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Vorwort

Hinweise zu diesem Handbuch
Dieses Handbuch enthält Informationen zum Einrichten, Installieren, Konfigurieren
und zur Verwendung von IBM

®

FAStT Storage Manager Version 7.02 in der
Betriebssystemumgebung Novell NetWare. Das Handbuch Installation und Unter-
stützung wendet sich an Systemadministratoren. Verwenden Sie es für folgende
Aufgaben:

v Zur Ermittlung der zur Installation der Speicherverwaltungssoftware erforderlichen
Hard- und Software.

v Zur Integration der erforderlichen Hardwarekomponenten in Ihr Netzwerk.

v Zur Installation der Speicherverwaltungssoftware.

v Falls erforderlich, zur Aktualisierung der Controller-Firmware.

v Zur Identifikation der NetWare-spezifischen Speicherverwaltungsmerkmale.

Aufbau des Handbuchs
„Kapitel 1. Einführung” auf Seite 1 bietet eine Übersicht zu IBM FAStT Storage
Manager Version 7.02 und beschreibt Verwaltungsmethoden für Speicher-
subsysteme, Konfigurationstypen, Installationstypen und Installationsvorausset-
zungen.

In „Kapitel 2. Vorbereitung der Installation” auf Seite 15 wird die Vorbereitung für
eine Netzwerkinstallation einschließlich der Einrichtung eines Microsoft

®

DHCP-Ser-
vers oder eines UNIX BOOTP-Servers behandelt sowie weitere Setup-Vorgänge
beschrieben.

In „Kapitel 3. Installieren der Software in einer Standardkonfiguration” auf Seite 33
wird die Vorgehensweise für die Installation der Software in einer Standard-
umgebung beschrieben.

„Kapitel 4. Beenden der Installation” auf Seite 39 beschreibt Enterprise Management
und Subsystem Management, das Ändern der NVSRAM-Konfigurationseinstellun-
gen und das Beenden der Installations-Tasks.

„Kapitel 5. Betriebssystemunterstützung” auf Seite 47 enthält Informationen zur Ver-
wendung der Speicherverwaltungssoftware mit Novell NetWare.

„Anhang A. Speichersubsystem-/Controllerinformationsdatensatz” auf Seite 55 ent-
hält ein Datenblatt, das kopiert werden kann und auf dem Sie Informationen über
Ihre Hardwareeinheiten festhalten können.

„Anhang B. Hinweise” auf Seite 57 enthält Produkthinweise und Marken-
informationen.

ix



Hinweise in diesem Handbuch
Dieses Handbuch enthält Bemerkungen zu Schwerpunkt- und Sicherheits-
informationen:

v Hinweise

Diese Hinweise umfassen wichtige Informationen, Anleitungen oder Ratschläge.

v Wichtig

Diese Hinweise enthalten Informationen oder Ratschläge, die Ihnen dabei helfen,
gefährliche Situationen oder Problemsituationen zu vermeiden.

v Achtung

Dieser Begriff weist auf die Gefahr der Beschädigung von Programmen, Einhei-
ten oder Daten hin. Ein mit ″Achtung″ gekennzeichneter Hinweis befindet sich
direkt vor der Anweisung oder der Beschreibung der Situation, die diese Beschä-
digung bewirken könnte.

v Vorsicht

Dieser Begriff verweist auf eine mögliche Gefährdung des Benutzers. Ein mit
″Vorsicht″ gekennzeichneter Hinweis befindet sich direkt vor der Beschreibung
eines potenziell gefährlichen Prozedurschritts oder einer solchen Situation.

Referenzliteratur
Die folgenden Publikationen liegen im Adobe Acrobat Portable Document Format
(PDF) auf der IBM FAStT Storage Manager-CD und im World Wide Web unter
http://www.ibm.com/pc/support/ vor.

Anmerkung: Die mit einem Stern (*) markierten Einträge der Liste bezeichnen Ver-
öffentlichungen, die als Druckausgabe im Lieferumfang der IBM
FAStT200- und FAStT200 High Availability (HA) Storage-Server ent-
halten sind.

v IBM FAStT Storage Manager Version 7.02 für Novell NetWare Installation und
Unterstützung (dieses Buch)

v IBM Netfinity FAStT Storage Manager Version 7.02 for Windows 2000 Installation
and Support Guide

v IBM Netfinity FAStT Storage Manager Version 7.02 for Windows NT Installation
and Support Guide

v IBM Netfinity FAStT Host Adapter Installation and User’s Handbook

v IBM FAStT200 and FAStT200 HA Storage Servers Installation and User’s Guide*

v IBM Netfinity FAStT500 RAID Controller Enclosure Unit Installation Guide

v IBM Netfinity FAStT500 RAID Controller Enclosure Unit User’s Reference

v IBM Netfinity Fibre Channel Storage Manager Concepts Guide

v IBM Netfinity Fibre Channel RAID Controller Unit User’s Handbook

Lesen Sie nach Abschluss der Tasks in dieser Dokumentation Installation und
Unterstützung die folgenden Onlinehilfefunktionen:

v Onlinehilfe zu IBM FAStT Storage Manager Version 7.02 Enterprise Manage-
ment. Diese Hilfefunktion stellt weitere Informationen zur Arbeit mit der
Verwaltungsdomäne zur Verfügung.

v Onlinehilfe für IBM FAStT Storage Manager Version 7.02 Subsystem Manage-
ment. Diese Hilfefunktion stellt weitere Informationen zur Verwaltung von
Speichersubsystemen zur Verfügung.
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Sie können von den Fenstern Enterprise Management und Subsystem Management
im IBM Netfinity Fibre Channel Storage Manager auf die Hilfefunktionen zugreifen.
Klicken Sie auf Hilfe auf der Funktionsleiste, oder drücken Sie die Taste F1.

Die Hilfefunktion enthält Betriebsinformationen, die bei allen Betriebsumgebungen
gleich sind. Informationen speziell zu Novell NetWare finden Sie in dieser Doku-
mentation Installation und Unterstützung.

IBM bietet zusätzliche Veröffentlichungen zum Kauf an. Ihr IBM Fachhändler oder
IBM Vertriebsbeauftragter kann Ihnen eine Liste der in Ihrem Land verfügbaren Ver-
öffentlichungen geben.

v In den Vereinigten Staaten und in Puerto Rico erreichen Sie IBM unter
001-800-426-7282.

v In Großbritannien erreichen Sie IBM unter 01705-565000 oder 0161-9056001.

v In Kanada erreichen Sie IBM unter 001-800-465-1234.

v In anderen Ländern setzen Sie sich mit der IBM Unterstützungsorganisation, die
für Ihren Bereich zuständig ist, Ihrem IBM Vertriebsbeauftragten oder Ihrem IBM
Vertragshändler in Verbindung.
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Kapitel 1. Einführung

IBM FAStT Storage Manager Version 7.02 für Novell NetWare ist ein auf Java
™

basierendes Tool zur Vereinfachung der Verwaltung der IBM Fibre Array Storage
Technology (FAStT)200- und FAStT200 HA Storage-Server, der Netfinity FAStT500
RAID Controller Enclosure Unit und der Netfinity Fibre Channel RAID Controller
Unit. Frühere Versionen von FAStT Storage Manager Version 7.02 sind unter der
Bezeichnung Netfinity Fibre Channel Storage Manager 7 bekannt. Die Software IBM
FAStT Storage Manager Version 7.02 bietet eine Schnittstelle für die Speicher-
verwaltung mit Hilfe der Informationen, die von den Controllern der Speicher-
subsysteme geliefert werden. Sie können die Speicherverwaltungssoftware auf
einer Verwaltungsstation, d. h. in dem System, das für die komplette Verwaltung
zuständig ist, oder in einem Teil dieses Systems, einem Netz, installieren. Die
Verwaltungsstation kommuniziert über ein Netzverwaltungsprotokoll, beispielsweise
SNMP (Simple Network Management Protocol) mit den Netzverwaltungsagenten,
die sich im verwalteten Knoten befinden. Wenn Sie ein Speichersubsystem verwal-
ten, das die auf einer Verwaltungsstation installierte Client-Software verwendet,
werden die Befehle an die Controller der Speichersubsysteme gesendet. Die
Controller-Firmware enthält die erforderlichen Informationen zur Ausführung der
Speicherverwaltungsbefehle. Der Controller übernimmt die Auswertung und Ausfüh-
rung der Befehle und gibt Status- und Konfigurationsdaten an die Client-Software
zurück. Im vorliegenden Handbuch beziehen sich die Begriffe Speicherverwaltungs-
software und Storage Manager 7.02 auf IBM FAStT Storage Manager Version 7.02
für Novell Netware. Einzelne Komponenten der Speicherverwaltungssoftware wer-
den namentlich gekennzeichnet.
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Wichtige Begriffe
Wenn Sie ein Upgrade von einer vorherigen Version der Speicherverwaltungs-
software durchführen, werden Sie feststellen, dass sich einige bekannte Bezeich-
nungen geändert haben. Machen Sie sich daher mit der neuen Terminologie ver-
traut. Tabelle 1 enthält eine Liste der Anforderungen des Maschinentyps und der
Speicherverwaltungssoftware. Tabelle 2 zeigt Ihnen eine Liste mit einigen der alten
und der neuen Bezeichnungen. Weitere Informationen finden Sie im IBM Netfinity
Fibre Channel Storage Manager Concepts Guide.

Tabelle 1. Voraussetzungen des Maschinentyps und der Speicherverwaltungssoftware

Produktname Maschi-
nentyp

Modell Produkt-
Release
und
Firmware-
Version

Freigegebene
Version der
Speicher-
verwaltungs-
software

IBM FAStT200 3542 1RU 4.x 7.02

IBM FAStT200 HA 3542 2RU 4.x 7.02

Netfinity Fibre Channel RAID Controller
Unit

3526 1RU 3.x, 4.x 6.22, 7.02

Netfinity FAStT500 RAID Controller
Enclosure Unit

3552 1RU 4.x 7.02

Tabelle 2. Alte und neue Terminologie

Bezeichnung in früheren Versionen Neue Bezeichnung

RAID-Modul Speichersubsystem

Laufwerkgruppe Array

Nummer der logischen Einheit (LUN)1 Logisches Laufwerk
1 Im Storage Manager 7.02 bezieht sich der Begriff Nummer der logischen Einheit (LUN) auf
eine logische Adresse, die durch den Host für den Zugriff auf ein bestimmtes logisches Lauf-
werk verwendet wird.

Der Unterschied zwischen den beiden folgenden Bezeichnungen ist im vorliegenden
Handbuch von besonderer Bedeutung.

Verwaltungsstation
Eine Verwaltungsstation ist ein System zur Verwaltung des Speicher-
subsystems. Dieses System muss nicht über den Fibre Channel-E/A-Pfad
an das Speichersubsystem angeschlossen werden.

Host- und Host-Computer
Die Begriffe Host und Host-Computer werden gleichwertig im gesamten
Handbuch verwendet. Beide Begriffe beziehen sich auf ein System, das
direkt über einen Fibre Channel-E/A-Pfad an das Speichersubsystem ange-
schlossen ist. Mit diesem System werden Daten (in der Regel in Dateiform)
vom Speichersubsystem abgerufen.

Anmerkung: Ein System kann gleichzeitig eine Verwaltungsstation und ein Host
sein.

2 IBM FAStT Storage Manager Version 7.02 für Novell NetWare: Installation und Unterstützung



Softwarekomponenten
Storage Manager 7.02 enthält die folgenden Softwarekomponenten:

v Client-Software

v Host-Agenten-Paket

Client-Software
Die Storage Manager 7.02-Client-Komponente (SM7client) bietet eine grafische
Benutzerschnittstelle zur Verwaltung der Speichersubsysteme über das Ethernet-
Netz oder vom Host aus. Der SM7client enthält zwei Hauptkomponenten:

v Enterprise Management . Die Komponente Enterprise Management kann zum
Hinzufügen, Entfernen und Überwachen der Speichersubsysteme innerhalb der
Verwaltungsdomäne verwendet werden.

v Subsystem Management . Die Komponente Subsystem Management kann für
die Verwaltung der Komponenten eines einzelnen Speichersubsystems verwen-
det werden.

Host-Agenten-Paket
Das Paket Storage Manager 7.02-Agent (SM7agent) besteht aus drei Software-
komponenten:

v Host-Agenten-Software . Verwenden Sie die Host-Agenten-Software, um
Speichersubsysteme über die Host-Ethernet-Verbindung zu verwalten. Die Host-
Agenten-Software erhält Anfragen von einer Verwaltungsstation, die mit einem
Host über eine Ethernet-Verbindung verbunden ist, und leitet die Anfragen über
den Fibre Channel-E/A-Pfad an die Controller des Speichersubsystems weiter.
Weitere Informationen über das Verwalten der Speichersubsysteme durch den
Host-Agenten finden Sie unter „Mit Host-Agent verwaltete Methode” auf Seite 4.

v Dienstprogramm SM7devices . Sie können das Dienstprogramm SM7devices
verwenden, um logischen Laufwerken des Speichersubsystems Einheitennamen
des Betriebssystems zuzuordnen. Weitere Informationen zur Verwendung von
SM7devices finden Sie unter „Verwenden des Dienstprogramms SM7devices” auf
Seite 53.

v Dienstprogramm Hot Add . Mit Hilfe des Dienstprogramms Hot Add können Sie
neu erstellte logische Laufwerke registrieren, ohne das Betriebssystem neu star-
ten zu müssen. Informationen zur Verwendung des Dienstprogramms Hot Add
finden Sie unter „Verwenden des Dienstprogramms Hot Add” auf Seite 52.
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Verwaltungsmethoden für Speichersubsysteme
Die Speicherverwaltungssoftware bietet zwei Methoden zur Verwaltung von
Speichersubsystemen: Die Verwaltung durch den Host-Agenten und die direkte Ver-
waltung. Je nach Konfiguration Ihrer Speichersubsysteme können Sie eine der bei-
den oder auch beide Methoden verwenden.

Mit Host-Agent verwaltete Methode
Wenn Sie diese Methode verwenden, verwalten Sie die Speichersubsysteme über
den Fibre Channel-E/A-Pfad zum Host. Das Speichersubsystem wird vom Host-
Computer oder der Verwaltungsstation verwaltet, die an den Host über eine Ether-
net-Verbindung angeschlossen ist.

Die Verwaltung von Speichersubsystemen durch den Host-Agenten weist folgende
Vorteile auf:

v Sie benötigen keine Ethernet-Kabel zu den Controllern.

v Sie benötigen keinen BOOTP-Server für die Verbindung zum Netz.

v Die Ausführung der Tasks zur Controllernetzkonfiguration, wie sie in „Kapitel 2.
Vorbereitung der Installation” auf Seite 15 beschrieben sind, ist nicht erforderlich.

v Wenn Sie Einheiten hinzufügen, müssen Sie lediglich für den Host einen Host-
Namen oder eine IP-Adresse angeben, nicht jedoch für die einzelnen Controller
in einem Speichersubsystem. Speichersubsysteme, die an den Host angeschlos-
sen sind, werden automatisch erkannt.

Die Verwaltung von Speichersubsystemen durch den Host-Agenten hat folgende
Nachteile:

v Sie können eine Nummer der logischen Einheit (logical unit number (LUN)) weni-
ger als die maximal zulässige Anzahl für das von Ihnen verwendete Betriebssys-
tem und den Host-Adapter verwenden.

v Für den Host-Agenten ist ein spezielles logisches Laufwerk, ein so genanntes
Access Volume (Zugriffsplatteneinheit) erforderlich, um mit den Controllern im
Speichersubsystem zu kommunizieren.

Anmerkung: Das Access Volume verwendet eine der LUNs. Unter NetWare ist es
möglich, die maximale Anzahl der LUNs zu verwenden, abhängig
davon, welches Service-Paket installiert ist und welcher Host-Adapter
verwendet wird. Weitere Informationen finden Sie unter „Anzahl der
unterstützten logischen Laufwerke” auf Seite 48.

Wichtig: Falls für das Host-System die maximale Anzahl der LUNs konfiguriert ist,
müssen Sie eine LUN für das Access Volume abgeben.

Abb. 1 auf Seite 5 zeigt ein System, in dem die Speichersubsysteme mit dem Host-
Agenten verwaltet werden.
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Aus technischen Gründen kann die folgende Abbildung nicht auf Deutsch zur Verfü-
gung gestellt werden.

Ethernet

Host-Computer

Controller

Controller

Controller

Controller

Fibre Channel-E/A-Pfad

Verwaltungsstation
(eine oder mehrere)

Ausführen der
Host-Agent-
Software

Speichersubsysteme

Hinweis: Der Host kann auch als
Verwaltungsstation agieren.

Direkt verwaltete Methode
Wenn Sie diese Methode verwenden, verwalten Sie die Speichersubsysteme direkt
mittels der Ethernet-Verbindung zu jedem Controller über das Netz. Um das
Speichersubsystem über diese Ethernet-Verbindungen verwalten zu können, müs-
sen Sie die IP-Adresse und den Host-Namen für jeden Controller definieren und an
die Ethernet-Anschlüsse an den Controllern des Speichersubsystems ein Kabel
anschließen.

Die direkte Verwaltung von Speichersubsystemen weist folgende Vorteile auf:

v Durch die Ethernet-Verbindungen mit den Controllern ist eine Verwaltungsstation,
auf der SM7client läuft, in der Lage, Speichersubsysteme zu verwalten, die mit
einem Host verbunden sind, auf dem NetWare oder andere durch Storage Mana-
ger 7.02 unterstützte Betriebssysteme ausgeführt werden.

v Sie müssen kein Access Volume verwenden, um mit den Controllern zu kommu-
nizieren, wie es bei der Host-Agenten-Software der Fall ist. Sie können die maxi-
male Anzahl an LUNs konfigurieren, die von Ihrem Betriebssystem und dem ver-
wendeten Host-Adapter unterstützt wird.

Die direkte Verwaltung von Speichersubsystemen hat folgende Nachteile:

v Für die Verbindung beider Controller des Speichersubsystems mit dem Netz sind
zwei Ethernet-Kabel erforderlich.

v Wenn Sie Einheiten hinzufügen, müssen Sie für jeden Controller eine IP-Adresse
oder einen Host-Namen angeben.

Abbildung 1. Durch den Host-Agenten verwaltete Speichersubsysteme
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v Sie benötigen einen BOOTP-Server, und es sind Vorbereitungs-Tasks für das
Netz erforderlich. Eine Zusammenfassung der Vorbereitungs-Tasks finden Sie
in Tabelle 8 auf Seite 17.

Abb. 2 zeigt ein System, in dem die Speichersubsysteme direkt verwaltet werden.

Aus technischen Gründen kann die folgende Abbildung nicht auf Deutsch zur Verfü-
gung gestellt werden.

Ethernet

Host-Computer

Fibre Channel-E/A-Pfad

Verwaltungsstation
(eine oder mehrere)

Controller

Controller

Controller

Controller

Speichersubsysteme

Installationsarten
Um Storage Manager 7.02 zu installieren, wählen Sie in der folgenden Liste die
Installationsart aus, die für Ihr Unternehmen am besten geeignet ist.

v Neue Speichersubsystemumgebung . Sie verfügen bisher noch nicht über
Speichersubsysteme. In diesem Fall installieren Sie neue Speichersubsysteme
mit Controllern des Maschinentyps 3526, 3542 oder 3552, die Firmware der Ver-
sion 4.00.0x verwenden. Sie beabsichtigen, diese neuen Speichersubsysteme
mit Storage Manager 7.02 zu verwalten. Um mit dieser Installation fortzufahren,
gehen Sie zu Schritt „Systemvoraussetzungen” auf Seite 11.

v Bestehende Speichersubsystemumgebung . Sie verfügen bereits über
Speichersubsysteme. In Tabelle 3 auf Seite 7 werden die Optionen für die
Verwaltung dieser bestehenden Speichersubsysteme erläutert.

Abbildung 2. Direkt verwaltete Speichersubsysteme
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Tabelle 3. Konfigurationen für bestehende Speichersubsysteme

Bestehende Speicher-
subsysteme mit:

Optionen

Controllern des Maschinen-
typs 3526 mit der Firmware-
Version 3.x

Option 1 — Führen Sie das Upgrade der Controller-Firmware
auf die Version 4.x aus, und verwalten Sie die Speicher-
subsysteme mit Storage Manager 7.02. Fahren Sie mit dem
Schritt „Systemvoraussetzungen” auf Seite 11 fort.

Option 2 — Installieren Sie die Speichersubsysteme, und ord-
nen Sie die Subsysteme dem Host zu, dem die bereits beste-
henden Speichersubsysteme zugeordnet sind. Diese
bestehenden und die neuen Speichersubsysteme werden als
″koexistierende Speichersubsysteme″ bezeichnet. Weitere
Informationen finden Sie unter „Verwalten neuer und beste-
hender Speichersubsysteme, die an denselben Host ange-
schlossen sind”.

Option 3 — Verwenden Sie weiterhin die Version 6.22 der
Speicherverwaltungssoftware zur Verwaltung dieser Speicher-
subsysteme, wenn diese an Hosts angeschlossen sind, die
nicht mit durch Storage Manager 7.02 verwalteten Speicher-
subsystemen verbunden sind. Fahren Sie mit dem Schritt
„Systemvoraussetzungen” auf Seite 11 fort.

Verwalten neuer und bestehender Speichersubsysteme, die an densel-
ben Host angeschlossen sind

Wenn Sie Storage Manager 7.02 installieren, müssen Sie festlegen, wie die beste-
henden Speichersubsysteme verwendet werden sollen. Bestehende Speicher-
subsysteme werden ″koexistierende Speichersubsysteme″ genannt, wenn sie an
denselben Host angeschlossen sind wie die mit Storage Manager 7.02 verwalteten
Speichersubsysteme und wenn die unter Tabelle 4 genannten Bedingungen erfüllt
sind.

Tabelle 4. Anforderungen für koexistierende Speichersubsysteme

Bestehende Speichersubsysteme Neue oder aktualisierte Speicher-
subsysteme

v Verwenden Sie Firmware der Version
3.01.x

v Werden mit Version 6.22 der Speicher-
verwaltungssoftware verwaltet

Anmerkung: Firmware- und Softwareebenen
stellen die Minimalanforderungen für Con-
troller des Maschinentyps 3526 dar, damit
eine Koexistenz mit neuen oder aktualisierten
Speichersubsystemen möglich ist.

v Verwenden Sie Firmware der Version
4.00.0x

v Werden mit Storage Manager 7.02 verwal-
tet
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Abb. 3 zeigt ein Beispiel für eine Umgebung, die koexistierende Speicher-
subsysteme umfasst.

Ethernet

Host-Computer

Controller

Controller

Controller

Controller

Fibre Channel-E/A-Pfad

Verwaltungsstation
(eine oder mehrere)

Verwaltungsstation
(eine oder mehrere)

Host-Agent

Client-Software
Speichersubsysteme

Version 6.22 der Speicherverwaltungs-
software muss auf einer Verwaltungs-
station (Netzwerk-Version) installiert
sein.

Firmware Version
3.01.x (Minimum)

Firmware Version 4.x

Version 7.02 der Speicherverwaltungs-
software muss entweder auf einer Ver-
waltungsstation oder einem Verwaltungs-
Host installiert sein.

Abbildung 3. Beispiel für eine Koexistenzinstallation
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Standardkonfiguration
Sie können Storage Manager 7.02 in einer Standardkonfiguration installieren. In
Tabelle 5 wird beschrieben, wo die Softwarekomponenten für die Speicher-
verwaltungssoftware bei einer Standardkonfiguration (nicht bei der Konfiguration
von Clusterservern) installiert werden.

Tabelle 5. Wo Softwarekomponenten in einer Standardkonfiguration installiert werden

Softwarekomponente Wo sie installiert wird Hinweise

Storage Manager 7.02-
Client (SM7client)

Sie können das SM7client-
Paket an folgenden Orten
installieren:

v Verwaltungsstation (für
direkte oder Host-Agenten-
Verwaltung)

v Host (für direkte oder
Host-Agenten-Verwaltung)

v Verwaltungsstationen
Wenn Sie die SM7client-Soft-
ware auf einer oder mehreren
Verwaltungsstationen installie-
ren, können Sie Speicher-
subsysteme entweder direkt
über Ethernet-Verbindungen zu
den Controllern oder über das
Netzwerk mit dem Host-Agenten
oder durch eine Kombination
beider Methoden verwalten.

v Host in einer vernetzten
Controllerkonfiguration
Wenn Sie die SM7client-Soft-
ware auf dem Host installieren,
können Sie die direkte Verwal-
tung, die Host-Agenten-Verwal-
tung oder eine Kombination
beider Methoden verwenden.
Ist die Host-Agenten-Software
installiert, muss der Host nicht
mit einem Netzwerk verbunden
werden. Auf dem Host-Compu-
ter muss jedoch die TCP/IP-
Software installiert sein, und Sie
müssen dem Host eine statische
IP-Adresse zuordnen.

v Host in einer nicht vernetzten
Controllerkonfiguration
Wenn Sie die SM7client-Soft-
ware in einer alternativen,
nicht vernetzten Controller-
konfiguration installieren,
können die mit dem Host ver-
bundenen Speichersubsysteme
über den Fibre Channel-E/A-
Pfad verwaltet werden.

Führen Sie die folgenden Schritte
aus, um eine nicht vernetzte Konfi-
guration einzurichten:

1. Installieren Sie das Host-Agen-
ten-Paket.

2. Installieren Sie auf dem Host
die TCP/IP-Software.

3. Weisen Sie dem Host eine sta-
tische IP-Adresse zu.
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Tabelle 5. Wo Softwarekomponenten in einer Standardkonfiguration installiert werden (Forts.)

Softwarekomponente Wo sie installiert wird Hinweise

Storage Manager 7.02-
Agent (SM7agent)

Host-Server Sie müssen die SM7agent-Soft-
ware auch dann installieren, wenn
Sie die Speichersubsysteme nicht
mit der Host-Agenten-Software
verwalten. Im Host-Agenten-Paket
sind wichtige Dienstprogramme
enthalten, die für den Betrieb der
Speicherverwaltungssoftware erfor-
derlich sind.

In der folgenden Abbildung ist ein Beispiel für eine Standardkonfiguration ein-
schließlich einer Verwaltungsstation dargestellt. Sie können den SM7client auf
einem eigenständigen Host installieren, wenn auf diesem Host die TCP/IP-Software
installiert ist und der Host eine statische IP-Adresse besitzt.

Aus technischen Gründen kann die folgende Abbildung nicht auf Deutsch zur Verfü-
gung gestellt werden.

Ethernet

Host-Computer

Controller

Controller

Controller

Controller

Fibre Channel-E/A-Pfad

Verwaltungsstation

Host-Agent

Die Client-Software ist
auf einem oder mehreren

Verwaltungsstationen oder
auf dem Host-Computer installiert.

Speichersubsysteme

Abbildung 4. Beispielstandardkonfiguration
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Systemvoraussetzungen
In diesem Abschnitt erhalten Sie detaillierte Informationen über die Hardware-, Soft-
ware- und Betriebsanforderungen für Storage Manager 7.02.

Hardwarevoraussetzungen
In der folgenden Tabelle werden die Hardwarekomponenten aufgeführt, die für die
Installation von Storage Manager 7.02 erforderlich sind. Aktuelle Informationen zu
Host-Adaptern und den zugehörigen Treibern finden Sie in der README-Datei auf
der Installations-CD IBM FAStT Storage Manager Version 7.02 für Novell NetWare
und auf der IBM Website unter der Adresse http://www.ibm.com/pc/support.

Tabelle 6. Hardwarevoraussetzungen für die Speicherverwaltungssoftware

Hardwarekomponente Voraussetzungen

Ein BOOTP-Server (nur für
direkt verwaltete Speicher-
subsysteme)

v UNIX
®

BOOTP-Server oder

v Novell DNS/DHCP-Services für NetWare 5 oder höher

v Microsoft BOOTP-kompatibler DHCP2-Server für Windows
NT

®
Server 4.0 mit Service Pack 5 oder später

Speichersubsysteme
(mindestens eins)

Speichersubsysteme mit Controllern, auf denen die Firmware-
Version 4.00.0x ausgeführt wird.
Anmerkung: Lesen Sie, bevor Sie beginnen, den Abschnitt
„Verwaltungsmethoden für Speichersubsysteme” auf Seite 4,
um Informationen über das Verwalten von Speicher-
subsystemen zu erhalten, wenn vorhandene Speicher-
subsysteme physisch mit dem gleichen Host verbunden sind,
den Sie mit den neuen Speichersubsystemen verbinden
möchten.

Fibre ChannelHost-Adapter Der IBM FAStT Host Adapter (Teilenummer: 00N6881) ist
gemeinsam mit der Speicherverwaltungssoftware getestet
worden.

Informationen zu spezifischen Host-Adapteranforderungen fin-
den Sie:

v In der README-Datei im Verzeichnis
\Netware51\Host_Adapter auf der Installations-CD.

v In der zum Host-Adapter mitgelieferten Dokumentation.

v Auf der IBM Support-Webseite unter der Adresse
http://www.ibm.com/pc/support

Fibre Channel Switch-
Verbünde (falls für die
gewünschte Konfiguration
erforderlich)

Folgende Switch-Verbünde für Fibre Channels wurden mit der
Speicherverwaltungssoftware getestet:

v IBM 8-Port Fibre Channel-Switch (Maschinentyp 2109-S08)

v IBM 16-Port Fibre Channel-Switch (Maschinentyp 2109-
S16)

Spezifische Fibre Channel-Switch-Konfigurationsan-
forderungen finden Sie:

v In der zum Switch mitgelieferten Dokumentation.

v Auf der IBM Produkt-Webseite unter der Adresse
http://www.ibm.com/products
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Tabelle 6. Hardwarevoraussetzungen für die Speicherverwaltungssoftware (Forts.)

Hardwarekomponente Voraussetzungen

Fibre Channel Verwalteter
Hub (falls für die gewünschte
Konfiguration erforderlich)

Der verwaltete Hub für IBM Fibre Channel (Maschinentyp:
3534) ist gemeinsam mit der Speicherverwaltungssoftware
getestet worden.

Spezifische Konfigurationsanforderungen für einen Fibre
Channel-verwalteten Hub finden Sie:

v In der zum verwalteten Hub mitgelieferten Dokumentation.

v Auf der IBM Website unter der Adresse
http://www.ibm.com/products

Verwaltungsstation oder Host
(für Client-Software)

Die Verwaltungsstation bzw. der Host benötigt:

v Intel
®

Pentium
®

oder einen äquivalenten Mikroprozessor
(mindestens 133 MHz)

v CD-ROM-Laufwerk

v Eine Maus oder eine vergleichbare Zeigereinheit

v Mindestens 64 MB Systemspeicher (vorzugsweise 128 MB)

v AGP- oder PCI-Videokarte (vorzugsweise AGP) (ISA-Karten
werden nicht unterstützt.)

v Bildschirmauflösung 1024 x 768 Pixel mit 64.000 Farben.
Minimaleinstellung: 800 x 600 Pixel mit 256 Farben

Bei der Einstellung von nur 256 Farben könnten beim Blät-
tern in den Onlinehilfefenstern Probleme auftreten. Verwen-
den Sie die Taste zum Zurückblättern und die Taste zum
Vorblättern , oder klicken Sie im Schiebebereich oberhalb
oder unterhalb der Schiebeleiste.

Zum Blättern in den Onlinehilfefenstern sind die Tasten mit
dem Aufwärtspfeil und dem Abwärtspfeil oder das Klicken in
der Schiebeleiste nicht geeignet.

v Hardwaregestützte Windows
®
-Beschleunigung

v 60 MB freier Festplattenspeicherplatz

v Ethernet-Netzschnittstellenkarte
Anmerkung: Desktop-Computer, die für den Videospeicher
den Systemspeicher verwenden, sollten mit der Speicher-
verwaltungssoftware nicht verwendet werden.
Wichtig: Viele PC-gestützte Server sind für Software mit
umfangreicher Grafik nicht ausgelegt. Falls Ihr Server mit
der reibungslosen Ausführung der Speicherverwaltungs-
software ohne Videozusatzeinrichtungen Schwierigkeiten
hat, muss möglicherweise ein Upgrade der Videokarte des
Servers durchgeführt werden.

Zum optimalen Einsatz von Laptop-Computern als Verwal-
tungsstationen werden die folgenden Mikroprozessoren emp-
fohlen:

v Intel, mindestens 366 MHz

v AMD, mindestens 400 MHz
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Firmware-Voraussetzungen
Storage Manager 7.02 arbeitet nur mit Controllern der Maschinentypen 3526, 3542
und 3552 sowie der Firmware-Version 4.00.0x.

Softwarevoraussetzungen
Die folgende Tabelle enthält die Installationsvoraussetzungen für jedes der
Softwarepakete.

Tabelle 7. Installationsvoraussetzungen für die Softwarepakete

Voraussetzung Software

SM7client SM7agent

Verfügbarer Platten-
speicherplatz

60 MB 1 MB

Administratorberechtigungen Nicht erforderlich Erforderlich

Mindesteinstellungen des
Bildschirms

800x600 Pixel, 256 Farben 640x480 Pixel, 256 Farben1

1 Diese Einstellungen gelten für die Installation der Software mit dem InstallShield.

Betriebssystemvoraussetzungen
Installieren Sie auf Verwaltungsstationen eines der folgenden Betriebssysteme:

v Windows NT Server 4.0 mit Service Pack 5 oder höher

v Windows NT Workstation 4.0 mit Service Pack 5 oder höher

v Windows NT 4.0 Enterprise Edition mit Service Pack 5 oder höher

v Windows 2000 Server

v Windows 2000 Professional

v Windows 2000 Advanced Server

Für Hosts installieren Sie das Betriebssystem Novell NetWare Version 5.1
mit Service Pack 1.
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Kapitel 2. Vorbereitung der Installation

Mit Hilfe der Informationen in diesem Kapitel können Sie die Installation der
Speicherverwaltungssoftware planen und vorbereiten.

Wie sollen die Speichersubsysteme verwaltet werden?
Wenn Sie sich noch nicht entschieden haben, erhalten Sie Informationen über die
beiden folgenden Methoden für das Verwalten von Speichersubsystemen unter
„Kapitel 1. Einführung” auf Seite 1:

v Direkte Verwaltung über eine Ethernet-Verbindung zu jedem Controller im
Speichersubsystem

v Host-Agenten-Verwaltung durch die Host-Agenten-Software, die auf dem Host-
Computer installiert ist, welcher mit dem Speichersubsystem verbunden ist

Sie können eine beliebige oder beide Methoden verwenden. Da jedoch viele der
Vorbereitungen für die Installation von der verwendeten Methode abhängig sind,
entscheiden Sie, wie Sie die Speichersubsysteme im Netzwerk verwalten möchten.

Abb. 5 auf Seite 16 zeigt ein Beispiel einer Netzwerkkonfiguration eines direkt ver-
walteten Speichersubsystems (siehe Netzwerk A). In diesem Netzwerk sind die fol-
genden Komponenten enthalten:

v BOOTP-Server

v Verwaltungsstation für SNMP-Traps (SNMP = Simple Network Management Pro-
tocol)

v Host, der durch einen Fibre Channel-E/A-Pfad mit einem Speichersubsystem ver-
bunden ist

v Verwaltungsstation, die durch ein Ethernet-Kabel mit den Controllern des
Speichersubsystems verbunden ist

Abb. 5 auf Seite 16 zeigt ein Beispiel einer Netzwerkinstallation eines durch einen
Host-Agenten verwalteten Speichersubsystems (siehe Netzwerk B). In diesem Netz-
werk sind die folgenden Komponenten enthalten:

v Ein Host, der durch einen Fibre Channel-E/A-Pfad mit einem Speichersubsystem
verbunden ist

v Eine Verwaltungsstation, die durch ein Ethernet-Kabel mit dem Host verbunden
ist
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Controller

Controller

Controller

Controller

Speicher-
subsystem
Bankein-
richtung

Speicher-
subsystem
Entwicklung

Fibre Channel-E/A-Pfad

Fibre Channel-E/A-Pfad

Netzwerk A
TCP/IP

Netzwerk B
TCP/IP

Ethernet

Router

Netzverwaltungs-
station

für SNMP-Traps)

Verwaltungsstation
(eine oder mehrere)

Verwaltungsstation
(eine oder mehrere)

Host-Computer
Denver

(IP-Adresse
153.79.144.12)

Host-Computer
Atlanta

(IP-Adresse
153.79.144.22)

BOOTP-Server

Host-Name: Denver_a
(IP-Adresse 153.79.144.13)

Hardware-Adresse 00.a0.b8.02.04.20
Host-Name: Denver_b

(IP-Adresse 153.79.144.14)
Hardware-Adresse 00.a0.b8.00.00.d8

Abbildung 5. BeispielNetz
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Vorbereiten einer Netzinstallation
Bevor Sie die Speicherverwaltungssoftware installieren, müssen die Netzkompo-
nenten eingerichtet sein und ordnungsgemäß funktionieren. Darüber hinaus müssen
Sie alle Host- und Controllerdaten, die für den ordnungsgemäßen Betrieb der Soft-
ware erforderlich sind, zur Hand haben. Führen Sie hierzu die Tasks aus, die in
Tabelle 8 zusammengefasst sind (siehe die entsprechenden Prozeduren). Verwen-
den Sie Tabelle 13 auf Seite 55 als Datenblatt, um das Speichersubsystem und die
Controllerinformationen zu protokollieren.

Tabelle 8. Netzwerk Zusammenfassung der Vorbereitungs-Tasks

Auszuführende Task Für direkte oder
Host-Agenten-Ver-
waltung?

Warum soll diese Task
ausgeführt werden?

Hier finden Sie
Anweisungen

Schritt 1 - Installieren
Sie alle Hardware-
komponenten (Host-
Computer, Speicher-
subsysteme, Kabel
usw.), die mit dem
Netz verbunden wer-
den sollen.

Beide Um sicherzustellen, dass
die Netzhardware vor-
handen ist

Spezielles
Installations-
handbuch für
die Hardware-
komponenten

Schritt 2 - Legen
Sie eine Namens-
konvention für die
Speichersubsysteme
fest, die an das Netz
angeschlossen sind,
und zeichnen Sie die
Konvention auf.

Beide Zum Hinzufügen der
Speichersubsysteme zur
Verwaltungsdomäne
nach der Installation der
Software

„Benennung der
Speichersubsysteme”
auf Seite 19.

Schritt 3 - Bestim-
men Sie die Ethernet-
Hardware-Adresse für
jeden Controller in
allen mit dem Netz
verbundenen
Speichersub-
systemen.

Direkt Zum Einrichten des
BOOTP-Servers, um
Netzkonfigurationsdaten
an die Controller weiter-
zugeben

„Ermitteln der Hard-
ware-Ethernet-
Adresse für jeden
Controller” auf Sei-
te 20.
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Tabelle 8. Netzwerk Zusammenfassung der Vorbereitungs-Tasks (Forts.)

Auszuführende Task Für direkte oder
Host-Agenten-Ver-
waltung?

Warum soll diese Task
ausgeführt werden?

Hier finden Sie
Anweisungen

Schritt 4 - Lassen
Sie sich vom Netz-
administrator die IP-
Adressen und Host-
Namen geben.

Beide Bei der Host-Agenten-
Verwaltung benötigen Sie
die IP-Adressen und
Host-Namen des Hosts,
auf dem die Software
ausgeführt werden soll.
Bei der direkten Verwal-
tung benötigen Sie die
IP-Adressen für jeden
Controller in den
Speichersubsystemen.
Mittels der IP-Adressen
wird der BOOTP-Server
so konfiguriert, dass er
die Netzkonfigurations-
daten an die Controller
weitergeben kann.
Außerdem verwenden
Sie die IP-Adressen der
Controller, um die Host-
Tabelle oder die Tabelle
für das Domänennamen-
system (DNS = Domain
Name System) zu instal-
lieren.

„Ermitteln der IP-
Adressen für Hosts
und Controller” auf
Seite 22.

Schritt 5 - Installieren
Sie den BOOTP-Ser-
ver, um die Netz-
konfigurationsdaten
für einen bestimmten
Controller zur Verfü-
gung zu stellen.

Direkt Netzkonfigurationsdaten
werden den Controllern
mittels des BOOTP-Ser-
vers zur Verfügung
gestellt.

„Einrichten des
BOOTP-Servers” auf
Seite 22.

Schritt 6 - Prüfen
Sie, ob die TCP/IP-
Software installiert ist,
und installieren Sie
die Host- oder DNS-
Tabelle.

Direkt Durch das Installieren
der Client-Software auf
einer Verwaltungsstation
wird sichergestellt, dass
die Verwaltungsstation so
konfiguriert wird, dass
die Controller über das
Netzwerk erreicht werden
können. Wenn die Client-
Software auf dem Host
installiert ist, ist die
TCP/IP-Software nach
wie vor für die erfolg-
reiche Kommunikation
zwischen der Client-Soft-
ware und den Controllern
erforderlich.

„Prüfen der TCP/IP-
Software und Ein-
richten der Host-
oder DNS-Tabelle”
auf Seite 32.

Schritt 7 - Schalten
Sie die Einheiten ein,
die an das Netz
angeschlossen sind.

Beide Um sicherzustellen, dass
alle Einheiten und Ver-
bindungen in Betrieb
sind.

Spezielles
Installations-
handbuch für
die Hardware-
komponenten
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Tabelle 9 zeigt einen Beispielinformationsdatensatz mit Einträgen für ein direkt ver-
waltetes Speichersubsystem und ein mit einem Host-Agenten verwaltetes Speicher-
subsystem.

Tabelle 9. Beispielinformationsdatensatz

Name des
Speicher-
subsystems
(siehe Seite 19)

Verwaltungsart
(siehe Seite 15)

Controller — Ethernet- und IP-
Adressen sowie Host-Name
(siehe Seiten 20 und 22)

Host —
IP-Adresse und
Host-Name
(siehe Seite 22)

Speicher-
subsystem-
Bankeinrichtung

Direkt Hardware-
Ethernet-Adresse
= 00a0b8020420

Hardware-
Ethernet-Adresse
= 00a0b80000d8

IP-Adresse =
153.79.144.13

IP-Adresse =
153.79.144.14

Host = Denver_a Host = Denver_b

Speicher-
subsystem-
Entwicklung

Host-Agent IP-Adresse =
153.79.111.22

Host = Atlanta

Tabelle 13 auf Seite 55 stellt ein Datenblatt bereit, auf dem Sie die Namen des
Speichersubsystems, Verwaltungstypen, Hardware-Ethernet-Adressen und IP-
Adressen protokollieren können. Erstellen Sie eine Kopie dieser Tabelle, und
vervollständigen Sie die Informationen für die Speichersubsysteme und Controller.
Verwenden Sie die in Tabelle 13 auf Seite 55 protokollierten Informationen, um die
BOOTP-Tabelle für Netzserver und den Host oder die DNS (Domain Name Sys-
tem)-Tabelle zu definieren. Die Informationen in Tabelle 13 auf Seite 55 sind Ihnen
beim Hinzufügen von Speichersubsystemen nach der Erstinstallation behilflich. Die
Spaltenüberschriften zeigen die Seitenreferenzen der detaillierten Anweisungen für
den Erhalt der Informationen. Einen Beispielinformationsdatensatz finden Sie in
Tabelle 9.

Benennung der Speichersubsysteme
Wenn Sie das Netzwerk installieren, entscheiden Sie über die Namenskonventionen
für die Speichersysteme. Nachdem Sie die Speicherverwaltungssoftware installiert
und erstmals gestartet haben, werden alle Speichersubsysteme in der Verwaltungs-
domäne als <unbenannt> angezeigt. Mittels des Fensters Subsystem Management
können Sie die einzelnen Speichersubsysteme umbenennen.

Die folgende Liste enthält Tipps für die Benennung von Speichersubsystemen:

v Die Zeichenzahl ist auf 30 Zeichen begrenzt. Alle vor- und nachgestellten Leer-
zeichen werden aus dem Namen gelöscht.

v Verwenden Sie ein eindeutiges, sinnvolles Namensschema, das leicht verständ-
lich und einprägsam ist.

v Vermeiden Sie willkürliche Namen oder Namen, die in der Zukunft schnell ihre
Bedeutung verlieren.

v In der Software werden die Namen der Speichersubsysteme mit dem Präfix
Speichersubsystem angezeigt. Deshalb wird ein in Entwicklung umbenanntes
Speichersubsystem folgendermaßen angezeigt:
Speichersubsystem-Entwicklung
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Wenn Sie sich für ein Benennungsschema entschieden haben, zeichnen Sie die
Namen für die Speichersubsysteme im Informationsdatensatz auf (Tabelle 13 auf
Seite 55).

Wenn Sie das Speichersubsystem direkt verwalten, fahren Sie mit „Ermitteln der
Hardware-Ethernet-Adresse für jeden Controller” fort. Wenn Sie das Speicher-
subsystem durch einen Host-Agenten verwalten, fahren Sie mit „Ermitteln der IP-
Adressen für Hosts und Controller” auf Seite 22 fort.

Ermitteln der Hardware-Ethernet-Adresse für jeden Controller
Verwenden Sie folgende Prozedur, wenn Sie das Speichersubsystem über Ether-
net-Verbindungen zu jedem Controller direkt verwalten möchten. Wenn Sie die
Speichersubsysteme mit Hilfe der Host-Agenten-Software verwalten möchten, über-
springen Sie diese Prozedur, und fahren Sie mit „Ermitteln der IP-Adressen für
Hosts und Controller” auf Seite 22 fort.

1. Entfernen Sie die Frontblende (Maschinentypen 3526 und 3552) von der
Controllereinheit, wie in Abbildung Abb. 6 dargestellt. Ziehen Sie vorsichtig den
Knopf heraus, um die Kontaktstifte «1¬ freizugeben. Schieben Sie anschließend
die Frontblende herunter «2¬.

2. Entriegeln und öffnen Sie die Hebel an den RAID-Controllern, Modelle 3526 und
3552.

Aus technischen Gründen können die folgenden beiden Abbildungen nicht auf
Deutsch zur Verfügung gestellt werden.

Abbildung 6. Entfernen der Frontblende der Controllereinheit (Maschinentypen 3526 und
3552)
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3. Die Etiketten für die Hardware-Ethernet-Adressen der Controller befinden sich
auf der Vorderseite jedes Controllers (siehe Abbildungen Abb. 7 und Abb. 8).

Die Nummer wird in der Form xx.xx.xx.xx.xx.xx (z. B. 00.a0.b8.00.00.d8) darge-
stellt.

4. Protokollieren Sie jede Ethernet-Adresse im Informationsdatensatz (Tabelle 13
auf Seite 55).

Hardware-Ethernet-
Adressenbezeichnung

Abbildung 7. Standort der Hardware-Ethernet-Adresse (Maschinentypen 3526 und 3552)

Hardware-Ethernet-
Adressenbezeichnung

Abbildung 8. Standort der Hardware-Ethernet-Adresse (Maschinentyp 3542)
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5. Um die Frontblende (Maschinentypen 3526 und 3552) wieder einzusetzen,
schieben Sie die Oberkante unter den Rand am Gehäuse «1¬. Drücken Sie
anschließend gegen die Unterkante der Frontblende, bis die Kontaktstifte in
den Befestigungslöchern einrasten «2¬ (siehe Abbildung Abb. 9).

6. Fahren Sie mit dem Schritt „Ermitteln der IP-Adressen für Hosts und Control-
ler” fort.

Ermitteln der IP-Adressen für Hosts und Controller
Sollen die Speichersubsysteme direkt verwaltet werden, ordnen Sie jedem Control-
ler in allen Speichersubsystemen im Netz eine eindeutige IP-Adresse und einen
zugehörigen Host-Namen zu (oder erfragen Sie diese Daten vom Netzadminist-
rator). Protokollieren Sie die IP-Adresse und den Host-Namen für jeden Con-
troller im Informationsdatensatz (Tabelle 13 auf Seite 55). Fahren Sie dann mit dem
Schritt „Einrichten des BOOTP-Servers” fort.

Einrichten des BOOTP-Servers
Wenn Sie die Speichersubsysteme über eine Ethernet-Verbindung zu jedem Cont-
roller direkt verwalten möchten, wählen Sie die Prozedur für die Einrichtung des
BOOTP-Servers aus:

v Wenn Sie einen BOOTP-kompatiblen DHCP-Server von NetWare verwenden,
fahren Sie mit dem Schritt „Verwenden von NetWare DHCP als BOOTP-kompa-
tibler Server” auf Seite 23 fort.

v Wenn Sie einen BOOTP-kompatiblen DHCP-Server von Microsoft verwenden,
fahren Sie mit dem Schritt „Verwenden von Microsoft DHCP als BOOTP-kompa-
tibler Server” auf Seite 26 fort.

v Wenn Sie einen UNIX-BOOTP-Server verwenden, fahren Sie mit dem Schritt
„Verwenden eines UNIX BOOTP-Servers” auf Seite 31 fort.

Wenn Sie die Speichersubsysteme mittels der Host-Agenten-Software verwalten
möchten, fahren Sie mit dem Schritt „Prüfen der TCP/IP-Software und Einrichten
der Host- oder DNS-Tabelle” auf Seite 32 fort.

Abbildung 9. Austauschen der Frontblende der Controllereinheit (Maschinentypen 3526 und
3552)
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Verwenden von NetWare DHCP als BOOTP-kompatibler Server
Wenn Sie einen DHCP-Server verwenden wollen, muss ein DHCP-Manager instal-
liert sein.

Vorbereitungen:
Vor dem Einrichten von DHCP müssen die folgenden Schritte ausgeführt werden:

1. Installieren Sie NetWare Version 5.1 auf dem ausgewählten Server oder den
ausgewählten Servern.

2. Installieren Sie die Novell Client-Software aus NetWare Version 5.1 auf den Cli-
ent-Computern, die zum Verwalten von DNS und DHCP eingesetzt werden sol-
len.

3. Installieren Sie die DNS/DHCP Management Console auf den Client-Compu-
tern, die zum Verwalten von DNS und DHCP eingesetzt werden sollen.

Installieren von DHCP-Services während der NetWare 5.1-Server-
installation
Verwenden Sie die folgende Prozedur, um DHCP-Services zu installieren:

1. Wählen Sie im Fenster Installation Options die Option Custom .

2. Aktivieren Sie im Fenster Components das Markierungsfeld Novell DNS/DHCP
Services.

3. Befolgen Sie die Anweisungen auf dem Bildschirm, um die Serverinstallation
von NetWare Version 5.1 abzuschließen.

Starten der DHCP Management Console
Doppelklicken Sie zum Starten der DNS/DHCP Management Console auf ihr Sym-
bol. Die DNS/DHCP Management Console kann auf einer Client-Workstation instal-
liert werden. Sie kann aber auch aus dem Menü Tools des Dienstprogramms Net-
Ware Administrator aufgerufen werden.

Nach der Installation der DNS/DHCP Management Console werden Sie aufgefor-
dert, den DNS-Baumstrukturnamen einzugeben, unter dem DHCP eingerichtet wer-
den soll.

Erstellen eines DHCP-Serverobjekts
Verwenden Sie die DHCP Management Console zum Erstellen und Einrichten eines
DHCP-Serverobjekts. Ein DHCP-Serverobjekt wird unter einem der folgenden
Objekte erstellt oder gesucht:

Organisation (Organization, O) Organisationseinheit (Organization Unit, OU) Land
(Country, C) Ort (Locality, L)

Führen Sie zum Erstellen und Einrichten eines DHCP-Serverobjekts die folgenden
Schritte aus:

1. Klicken Sie auf die Registerkarte DHCP Service der DHCP Management Con-
sole. Das Objekt Our Network ist das einzige Objekt, das im linken Teilfenster
der DHCP Management Console angezeigt wird.

2. Klicken Sie in der Funktionsleiste auf Create .

Das Fenster Create New DHCP Object wird geöffnet, in dem Sie ein DHCP-
Serverobjekt, ein Teilnetzobjekt oder ein Teilnetz-Pool-Objekt erstellen können.

3. Wählen Sie DHCP Server, und klicken Sie auf OK.

Das Fenster Create DHCP Server wird geöffnet, in dem Sie zur Auswahl eines
Serverobjekts aufgefordert werden.
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4. Verwenden Sie den Knopf Browse, um einen Server auszuwählen, und klicken
Sie dann auf Create .

Dadurch wird das DHCP-Serverobjekt DHCP_servername in NDS erstellt.

Suchen Sie in der DHCP Management Console das Symbol für den DHCP-Ser-
ver am unteren Rand der Registerkarte DHCP Service. Das Serverobjekt wird
mit einer hindurchführenden roten Linie dargestellt. Durch diese rote Linie wird
angezeigt, dass die DHCP-Server-NLM sowie die zugehörigen NLMs nicht
installiert worden sind.

Erstellen eines Teilnetzobjekts
Die DNS/DHCP Management Console kann verwendet werden, um für jedes Teil-
netz, dem Adressen zugewiesen werden sollen, ein DHCP-Teilnetzobjekt zu erstel-
len und einzurichten.

Führen Sie zum Erstellen und Einrichten eines Teilnetzobjekts die folgenden
Schritte aus:

1. Klicken Sie auf die Registerkarte DHCP Service der DNS/DHCP Management
Console.

Das Objekt Our Network ist das einzige Objekt, das im linken Teilfenster der
DNS/DHCP Management Console angezeigt wird.

2. Klicken Sie in der Funktionsleiste auf Create .

Das Fenster Create New DHCP Object wird geöffnet, in dem Sie ein DHCP-
Serverobjekt, ein Teilnetzobjekt oder ein Teilnetz-Pool-Objekt erstellen können.

3. Wählen Sie Subnet , und klicken Sie auf OK.

Das Fenster Create Subnet wird geöffnet. Geben Sie für jedes zu erstellende
Teilnetz die folgenden Daten in den angebotenen Feldern ein: Teilnetzname,
NDS-Kontext, Teilnetzadresse und Teilnetzmaske. Haben Sie einen DHCP-
Standardserver eingerichtet, wird dessen Name angezeigt und kann geändert
werden.

Klicken Sie das Markierungsfeld Define Additional Properties an, um eine detail-
liertere Konfiguration einschließlich der für jedes Teilnetz typischen DHCP-Optio-
nen zu ermöglichen.

4. Geben Sie die erforderlichen Daten ein, und klicken Sie dann auf Create .

Das DHCP-Teilnetzobjekt wird erstellt und im linken Teilfenster der DNS/DHCP
Management Console angezeigt.

Erstellen von Teilnetzadressbereichen
Die DNS/DHCP Management Console kann verwendet werden, um für jeden Pool
von Adressen, die durch DHCP dynamisch zugewiesen werden sollen, Objekte für
Teilnetzadressbereiche zu erstellen und einzurichten.

Führen Sie zum Erstellen und Einrichten eines Objekts für Teilnetzadressbereiche
die folgenden Schritte aus:

1. Klicken Sie auf die Registerkarte DHCP Service der DNS/DHCP Management
Console.

2. Wählen Sie das Teilnetzobjekt aus, unter dem das Teilnetzadressbereichs-Ob-
jekt erstellt werden soll, und klicken Sie dann auf Create .

Das Fenster Create New DHCP Record wird geöffnet.
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3. Wählen Sie Subnet Address Range , und klicken Sie auf OK. Das Fenster
Create New Subnet Address Range wird geöffnet.

4. Geben Sie für den Teilnetzadressbereich einen Namen ein, legen Sie die
Anfangs- und die Endadresse des Bereichs fest, und klicken Sie dann auf
Create .

Wenn Sie das Markierungsfeld Define Additional Properties aktivieren, wird ein
Fenster für detailliertere Informationen zum Bereich geöffnet, in dem Sie detail-
liertere Konfigurationsdaten angeben können.

Erstellen von IP-Adressobjekten
Die DNS/DHCP Management Console kann verwendet werden, um IP-Adress-
objekte zu erstellen und einzurichten, die speziellen Einheiten zugewiesen oder von
der dynamischen Zuordnung ausgeschlossen werden sollen. Erstellen Sie für jede
dieser Einheiten oder Adressen ein IP-Adressobjekt. Für das Zuweisen einer
bestimmten Adresse zu einem Client ist es erforderlich, die MAC-Adresse (MAC =
Media-Access Control) oder die ID des Clients anzugeben.

Wenn Sie Teilnetze und Teilnetzadressbereiche eingerichtet haben, brauchen Sie
keine einzelnen IP-Adressen einzurichten, es sei denn, Adressen sollen manuell
zugewiesen oder von der Zuordnung ausgeschlossen werden.

Führen Sie zum Erstellen und Einrichten eines IP-Adressobjekts die folgenden
Schritte aus:

1. Klicken Sie auf die Registerkarte DHCP Service der DNS/DHCP Management
Console.

2. Wählen Sie das Teilnetzobjekt mit der IP-Zieladresse aus, und klicken Sie dann
in der Funktionsleiste auf Create .

Das Fenster Create New DHCP Object wird geöffnet.

3. Wählen Sie IP Address , und klicken Sie auf OK.

Das Fenster Create IP Address wird geöffnet.

4. Geben Sie die IP-Adresse ein, die zugewiesen oder davon ausgenommen wer-
den soll, legen Sie den Zuordnungstyp fest, und klicken Sie dann auf Create .

Falls Sie sich für den Manuellen Zuordnungstyp entschieden haben, müssen
Sie entweder im Feld Client Identifier oder im Feld MAC Address Daten einge-
ben. Sie können den MAC-Typ auch festlegen, indem Sie in das entsprechende
Feld klicken; der Standardwert lautet FF Any.

Starten des DHCP-Servers
Nach dem Erstellen und Einrichten eines DHCP-Servers und dem Konfigurieren der
für DHCP erforderlichen NDSTM-Objekte geben Sie in der DHCP-Serverkonsole
den folgenden Befehl ein:
LOAD DHCPSRVR

Nach dem Installieren von DHCPSRVR.NLM kann der DHCP-Server auf Client-An-
forderungen reagieren und IP-Adressen zuweisen.

Anmerkung: Weitere Informationen zum Einrichten, Konfigurieren und Verwenden
der Novell DNS/DHCP Services finden Sie in der Dokumentation zu
NetWare 5.1 auf der Novell Dokumentations-CD oder unter der
Adresse http://www.novell.com/documentation.
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Verwenden von Microsoft DHCP als BOOTP-kompatibler Server
Sie müssen eine Version von DHCP verwenden, mit der die statische Adressierung
von BOOTP unterstützt wird. Wenn Sie einen DHCP-Server verwenden wollen,
muss ein DHCP-Manager installiert sein. Wenn ein DHCP-Manager im System
installiert ist, fahren Sie mit dem Schritt „Einrichten eines DHCP-Servers” fort. Wenn
kein DHCP-Manager installiert ist, verwenden Sie das folgende Installations-
verfahren:

Installieren des DHCP-Managers
Verwenden Sie die folgende Prozedur, um den DHCP-Manager zu installieren:
1. Klicken Sie auf Start → Settings → Control Panel .
2. Doppelklicken Sie auf das Symbol Network .
3. Das Fenster Network wird geöffnet. Klicken Sie auf die Registerkarte Services .
4. Klicken Sie auf DHCP Server Network Services → Add .
5. Installieren Sie Windows NT Service Pack 5 oder höher erneut, um die neuen

DHCP-Einstellungen oder Informationen aus dem Service Pack zu erhalten.
6. Fahren Sie mit Schritt „Einrichten eines DHCP-Servers” fort.

Einrichten eines DHCP-Servers
Verwenden Sie die nachstehende Prozedur sowie Tabelle 13 auf Seite 55, um den
DHCP-Server einzurichten.

Anmerkung: Bei den folgenden Schritten und Fensterbeispielen wird davon ausge-
gangen, dass Sie einen Windows NT DHCP-Server unter Verwen-
dung des zugehörigen DHCP-Managers konfigurieren.

1. Klicken Sie auf Start → Programs → Administrative Tools → DHCP
Manager .

Das Fenster DHCP Manager wird geöffnet.

2. Erstellen Sie einen Bereich. Mit einem Bereich wird eine Gruppe von Controllern
definiert, die Sie mit dem DHCP-Server konfigurieren möchten.
a. Klicken Sie auf Local Machine .
b. Klicken Sie auf Scope → Create .

Das Fenster Create Scope wird geöffnet.

Abbildung 10. Fenster Create Scope (Local)
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c. Geben Sie die Anfangs- und End-IP-Adressen der Controller ein, die im
Netzwerk konfiguriert werden sollen.

Wenn Sie beispielsweise 50 Controller im Teilnetz 153.79.144.0 konfigurie-
ren möchten, legen Sie die Anfangsadresse auf 153.79.144.1 und die End-
adresse auf 153.79.144.50 fest.

Anmerkung: Wenn in jedem Feld nicht mindestens drei Zeichen enthalten
sind, drücken Sie die Taste Punkt (.), um zum nächsten Feld
zu wechseln. Wenn Sie mit nur einem Controller arbeiten,
geben Sie dessen Adresse sowohl als Anfangs- als auch als
Endadresse ein.

d. Geben Sie die Teilnetzmaske ein. (Sie erhalten sie vom Netzwerk-
administrator.)

e. Legen Sie die Gültigkeitsdauer der Lease auf Unlimited fest. Dadurch wird
die DHCP-Verbindung permanent.

f. Geben Sie einen Bereichsnamen und einen Kommentar ein.
g. Klicken Sie auf OK.
h. Wenn der Bereich erfolgreich erstellt wurde, klicken Sie auf Yes, um ihn zu

aktivieren.

Sie kehren zum Fenster DHCP Manager zurück.

3. Gehen Sie wie folgt vor, um die globalen Bereichsparameter zu konfigurieren.
Durch die Bereichsparameter können Sie die Einstellungen konfigurieren, die für
alle Controller gültig sein sollen. Informationen darüber, welche Parameter für
die gesamte Gruppe gelten sollen, finden Sie unter Tabelle 8 auf Seite 17.

Anmerkung: Sie können zu einem späteren Zeitpunkt mit Schritt 5 auf Seite 29
Optionen für spezielle Controller anlegen.

a. Klicken Sie auf DHCP Options → Global .

Das Fenster DHCP Options: Global wird geöffnet.

Anmerkung: Die RMS- und NMS-Einträge (RMS = Remote Management
Station, NMS = Network Management Station), die in früheren
Versionen der Speicherverwaltungssoftware Version 6.22 ver-
wendet wurden, sind nicht erforderlich, wenn Sie mit dem Sto-
rage Manager 7.02 Speichersubsysteme mit Controllern mit
der Firmware Version 4.00.0x verwalten.

Abbildung 11. Fenster DHCP Options: Global
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b. Wählen Sie aus der Liste Unused Options ein Element aus, und klicken Sie
auf Add , um dieses Element in die Liste Active Options zu verschieben.
Jeder Option ist ihre Kennnummer vorangestellt.

c. Klicken Sie auf Value , um der aktiven Option einen Wert zuzuordnen.

Wenn Value ausgeblendet ist, wird das Auswahlfenster Edit Array im unteren
Teil des Fensters geöffnet.

d. Wenn Sie eine IP-Adresse hinzufügen müssen, klicken Sie auf Edit Array .

Der IP Address Array Editor wird geöffnet.

Abb. 12 zeigt ein Beispiel, wie Sie die IP-Adresse für eine Verwaltungs-
station hinzufügen.

Wenn Sie keine IP-Adresse hinzufügen müssen, fahren Sie mit Schritt 4 auf
Seite 29 fort.

e. Geben Sie die eindeutige IP-Adresse für die hinzugefügte Option ein.

f. Klicken Sie auf Add , um die neue IP-Adresse in die Liste der IP-Adressen zu
verschieben.

g. Klicken Sie auf OK. Das Fenster DHCP Options: Global wird erneut geöff-
net.

h. Wiederholen Sie die Schritte 3d bis 3g, bis alle globalen Optionen hinzuge-
fügt wurden.

Wenn Sie das Hinzufügen der globalen Bereichsparameter abgeschlossen
haben, klicken Sie im Fenster DHCP Options: Global auf OK. Das Fenster
DHCP Manager wird erneut geöffnet.

Abbildung 12. Fenster IP Address Array Editor
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4. Mit der folgenden Prozedur können Sie eine Reservierung für jeden Controller
erstellen: Verwenden Sie das Datenblatt, das Sie unter Tabelle 13 auf Seite 55
erstellt haben, um sicherzugehen, dass Sie alle Controller für jedes Speicher-
subsystem im Netz aufnehmen.

a. Klicken Sie auf Scope → Add Reservations .

b. Geben Sie im Feld IP Address die IP-Adresse für den ersten Controller auf
Ihrem Datenblatt ein.

c. Geben Sie im Feld Unique Identifier die Ethernet-Adresse für die
Controllerhardware ein.

d. Geben Sie im Feld Client Name den aus acht Buchstaben bestehenden
Namen des Controllers ein.

e. Klicken Sie auf Add .

f. Wiederholen Sie die Schritte 4b bis 4e für jeden Controller auf Ihrem Daten-
blatt. Siehe Tabelle 13 auf Seite 55.

g. Wenn Sie die Eingabe der Informationen für alle Controller abgeschlossen
haben, klicken Sie auf Close .

Sie kehren zum Fenster DHCP Manager zurück.

5. Gehen Sie wie folgt vor, um die controllerspezifischen Optionen zu konfigurie-
ren. Durch die Erstellung einer controllerspezifischen Option können Sie einen
Konfigurationseintrag für einen Controller einem bestimmten Controller zuord-
nen, den Sie in Schritt 4 hinzugefügt haben.

Anmerkung: Wenn Sie eine Option auf Global Scope festlegen, wird diese
Option auf jeden Controller in dieser Gruppe angewendet und
muss nicht erneut hinzugefügt werden.

a. Klicken Sie auf Scope → Active Leases .

Das Fenster Active Leases wird geöffnet.

b. Wählen Sie einen Controller aus der Liste aus.

Abbildung 13. Fenster Active Leases
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c. Klicken Sie auf Properties . Bei der eindeutigen ID (UID) handelt es sich um
die Hardware-Ethernet-Adresse, die Sie in Schritt 4c hinzugefügt haben.

d. Klicken Sie auf Options . Das Fenster DHCP Options: Reservations wird
geöffnet.

e. Wählen Sie aus der Liste Unused Options einen Eintrag aus, und klicken
Sie auf Add , um den Eintrag in die Liste Active Options zu verschieben.

f. Klicken Sie auf Value , um der aktiven Option einen Wert zuzuordnen.

g. Geben Sie die Daten für den Wert der Option ein. Geben Sie beispielsweise
im Feld Zeichenfolge unter Host-Name den Host-Namen für den Controller
(von Ihrem Datenblatt, siehe Tabelle 13 auf Seite 55) ein. Klicken Sie auf
Edit , wenn der Wert, den Sie hinzufügen müssen, eine IP-Adresse für einen
Router ist.

h. Wiederholen Sie die Schritte 5e bis 5g, bis Sie alle spezifischen Optionen
für diesen Controller hinzugefügt haben.

i. Klicken Sie auf OK.

Sie kehren zum Fenster Add Option Type zurück.

j. Klicken Sie auf OK.

Sie kehren zum Fenster Active Leases zurück.

k. Wiederholen Sie die Schritte 5b bis 5j, bis Sie alle controllerspezifischen
Optionen für jeden Controller hinzugefügt haben.

Wenn Sie die spezifischen Optionen für alle Controller hinzugefügt haben,
klicken Sie im Fenster Active Leases auf OK.

Das Fenster DHCP Manager wird erneut geöffnet.

6. Fahren Sie mit Schritt „Prüfen der TCP/IP-Software und Einrichten der Host-
oder DNS-Tabelle” auf Seite 32 fort.

Abbildung 14. Fenster Add Option Type
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Verwenden eines UNIX BOOTP-Servers
Tabelle 10 und Tabelle 13 auf Seite 55 enthalten Informationen zum Einrichten der
BOOTP-Tabelle und zum Erstellen der erforderlichen Einträge zwecks Unterstüt-
zung der Controller in den Speichersubsystemen. Verwenden Sie einen Texteditor,
um die bootptab-Datei im /etc-Verzeichnis zu editieren.

Tabelle 10. Erforderliche Einträge für das Einrichten des UNIX-BOOTP-Servers

Eintrag Beschreibung Beispielformat
im BOOTP-Ser-
ver

Teilnetzmaske Maske, die zur Weiterleitung von Paketen an
definierte Teilnetze verwendet wird

Punktnotation
(sm=255.255.248.0)

Router IP-Adresse des Hosts, der die Pakete an Netz-
werke weiterleitet

Punktnotation
(gw=153.79.144.2)

Host-Name für den
Controller

Host-Name, der dem Controller zugeordnet ist
(siehe Tabelle 13 auf Seite 55)

Host-Name
(Denver_a)

IP-Adresse IP-Adresse des Controllers (siehe Tabelle 13 auf
Seite 55)

Punktnotation
(ip=153.79.144.13)

Ethernet-Adresse Die Ethernet-Adresse der Controllerhardware
(siehe Tabelle 13 auf Seite 55)

Hexadezimale
Notation
(ha=00a0b8020420)

Im folgenden Beispiel einer BOOTP-Tabelle wird angenommen, dass Sie einen
UNIX BOOTP-Server, wie z.B. einen Server im Netzwerk, konfigurieren, wie in
Abb. 5 auf Seite 16 dargestellt. Der Eintrag s4.default:\ gibt Einstellungen an, die für
alle Controller gemeinsam gelten. Mit dem Eintrag tc=s4.default:\ wird diese allge-
meine Einstellungsgruppe einem bestimmten Controller zugeordnet.
s4.default:\ (allgemeine Einstellungen)
ht=ether:\
sm=255.255.248.0:\
gw=153.79.144.2:\
hn:
denver_a:\
tc=s4.default:\ (verweist auf allgemeine Einstellungen)
ip=153.79.144.13:\
ha=00a0b8020420:
denver_b:\
tc=s4.default:\
ip=153.79.144.14:\
ha=00a0b80000d8"

Wenn Sie die BOOTP-Tabelle eingerichtet haben, gehen Sie folgendermaßen vor:

1. Schalten Sie die Speichersubsysteme ein, so dass die Parameter in der
BOOTP-Tabelle wirksam werden.

2. Wenn Sie die BOOTP-Tabelle eingerichtet haben, fahren Sie mit dem Schritt
„Prüfen der TCP/IP-Software und Einrichten der Host- oder DNS-Tabelle” auf
Seite 32 fort.
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Prüfen der TCP/IP-Software und Einrichten der Host- oder DNS-Tabelle
Stellen Sie sicher, dass die Host-Namen für die Controller mit den entsprechenden
IP-Adressen für die Controller übereinstimmen. Mit der folgenden Prozedur können
Sie prüfen, ob die TCP/IP-Software auf der Verwaltungsstation installiert ist und die
Host- oder DNS-Tabelle einrichten.

Anmerkung: Sie können anstatt DNS auch den Windows Internet Name Service
(WINS) verwenden.

1. Klicken Sie auf Start → Settings → Control Panel → Network → Protocols , um
zu prüfen, ob die TCP/IP-Software ordnungsgemäß installiert und konfiguriert
ist.

Anmerkung: Wenn die TCP/IP-Software nicht ordnungsgemäß installiert
wurde, nehmen Sie eine erneute Installation von der Windows NT
4.0-Installations-CD vor. Klicken Sie auf Start → Settings → Cont-
rol Panel → Network → Protocols → Add → Have Disk .

2. Aktualisieren Sie entweder die Host- oder die DNS-Tabelle, um einen Host-Na-
men anzugeben, der einer IP-Adresse zugeordnet werden kann. Wenn Sie nicht
über DNS verfügen, bearbeiten Sie die beiden Host-Tabellen, die sich in den fol-
genden Verzeichnissen befinden:
c:\winnt\system32\drivers\etc\hosts

c:\winnt\system32\drivers\etc\imhosts

Wenn Sie beispielsweise die Host-Tabellen für die Controller einrichten möch-
ten, die mit Netz A verbunden sind (Abb. 5 auf Seite 16), erstellen Sie mit einem
Texteditor die folgenden Einträge für IP-Adressen und Controllernamen:

IP-Adresse Host-Name für den Controller

127.0.0.01 localhost

153.79.144.13 denver_a

153.79.144.14 denver_b

3. Wenn Sie Speichersubsysteme mit einer Firewall mit Paketfilter verwalten
möchten, konfigurieren Sie die Firewall so, dass Anschluss 2463 für TCP-Daten
geöffnet wird. Andernfalls fahren Sie mit „Kapitel 3. Installieren der Software in
einer Standardkonfiguration” auf Seite 33 fort.
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Kapitel 3. Installieren der Software in einer Standard-
konfiguration

In diesem Kapitel wird beschrieben, wie Sie die Speicherverwaltungssoftware in
einer Standardkonfiguration installieren.

Wichtig: Suchen Sie auf jedem Installationsdatenträger nach einer README-Datei.
Diese README-Datei enthält wichtige Informationen, die bei der Erstellung dieser
Dokumentation Installation und Unterstützung noch nicht zur Verfügung standen.

Zur Installation der Speicherverwaltungssoftware stehen zwei Konfigurationen zur
Verfügung:

v Sie verfügen bisher noch nicht über Speichersubsysteme. In diesem Fall installie-
ren Sie neue Speichersubsysteme mit Controllern der Maschinentypen 3526,
3542 oder 3522 mittels der Firmware-Version 4.00.0x und verwalten diese neuen
Speichersubsysteme mit Storage Manager 7.02. Wenn dieser Fall auf Sie zutrifft,
fahren Sie mit dem Schritt „Installationsprozess” auf Seite 34 fort.

v Sie verfügen bereits über Speichersubsysteme mit Controllern der Maschinen-
typen 3526, 3542 oder 3552. In diesem Fall können Sie folgendermaßen vorge-
hen:

– Aktualisieren Sie die Controller-Firmware der vorhandenen Speicher-
subsysteme auf die Version 4.00.0x, und verwalten Sie die Subsysteme
mit Storage Manager 7.02.

– Verwalten Sie die Speichersubsysteme weiterhin mit der Version 6.22 der
Speicherverwaltungssoftware. Sie können diese Speichersubsysteme auch in
Koexistenz mit neuen Speichersubsystemen verwalten, die Sie mit Storage
Manager 7.02 verwalten. Informationen darüber, ob Sie über koexistierende
Speichersubsysteme verfügen, finden Sie unter „Installationsarten” auf Seite 6.

Bestimmen Sie den für Sie geeigneten Installationsprozess anhand von Tabelle 11
auf Seite 34.
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Tabelle 11. Ermitteln des Installationsprozesses in einer Standardkonfiguration

Aktuelle Umgebung Geplante Umgebung Aktion

Bestehende Speicher-
subsysteme mit Con-
trollern, auf denen
Firmware Version 3.x
ausgeführt wird

Upgrade auf Firmware Version
4.00.0x

Weitere Informationen hierzu
finden Sie in der README-Da-
tei im Verzeichnis \Netware51\
auf der Installations-CD.

Keine bestehenden
Speichersubsysteme

Neue Speichersubsysteme mit
Controllern, für die die Firmware-
Version 4.00.0x verwendet wird
und die mit Storage Manager 7.02
verwaltet werden

Fahren Sie mit dem Schritt
„Installationsprozess” fort.

Bestehende Speicher-
subsysteme mit Con-
trollern, die mit den
Firmware-Versionen
4.00.00 bis 4.00.01
arbeiten

Upgrade von Speichersubsys-
temen mit Controllern, für die die
Firmware Version 4.00.0x verwen-
det wird und die mit Storage
Manager 7.02 verwaltet werden

1. Fahren Sie mit dem Schritt
„Installationsprozess” fort.

2. Aktualisieren Sie mit Hilfe
der Onlinehilfefunktion der
Speicherverwaltungs-
software NVSRAM und
Firmware auf Version
4.00.0x.

Weiterverwendung der bestehen-
den Versionen 4.00.00 bis 4.00.01
der Controller-Firmware und Ver-
waltung mit Storage Manager
7.02. Weitere Informationen
hierzu finden Sie in der README-
Datei im Verzeichnis \Netware51\
auf der Installations-CD.

Fahren Sie mit Schritt
„Installationsprozess” fort.

Installationsprozess
Dieser Installationsprozess gilt für die folgenden Installationsarten:

v Neue Installationen

v Beim Installieren mit bestehenden Speichersubsystemen

Beginnen Sie die Installation der Speicherverwaltungssoftware mit „Installieren des
Paketes SM7client” auf Seite 35. Fahren Sie mit dem Prozess fort, bis der Abschnitt
„Installieren des Host-Agent-Paketes” auf Seite 37 abgeschlossen ist.
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Abb. 15 zeigt ein Ablaufdiagramm des Installationsprozesses.

Installieren Sie das Client-Paket.

Installieren Sie das Host-Agent-Paket.

Öffnen Sie das Fenster
Enterprise Management

Öffnen Sie das Fenster
Subsystem Management

Die Installation ist abgeschlossen.
Weiter mit Kapitel 4,

Betriebssystemunterstützung

Installieren des Paketes SM7client
Verwenden Sie folgende Prozedur, um SM7client auf einer Verwaltungsstation zu
installieren, die mit Novell NetWare 5.1 mit Service Pack 1 konfiguriert ist:

Um SM7client auf einer Verwaltungsstation zu installieren, die mit einem der folgen-
den Betriebssysteme konfiguriert ist, richten Sie sich nach den Installationsan-
weisungen im IBM Netfinity FAStT Storage Manager Version 7.02 for Windows NT
Installation and Support Guide bzw. im IBM Netfinity FAStT Storage Manager Ver-
sion 7.02 for Windows 2000 Installation and Support Guide.

v Windows NT Server 4.0 mit Service Pack 5 oder höher

v Windows NT 4.0 Enterprise Edition mit Service Pack 5 oder höher

v Windows NT Workstation 4.0 mit Service Pack 5 oder höher

v Windows 2000 Advanced Server

v Windows 2000 Professional

v Windows Advanced Server

Abbildung 15. Installationsprozess
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Hinweise:

v Wenn Sie lediglich eine Netzverwaltungsstation konfigurieren, müssen Sie nur
den SM7client installieren.

v Wenn Sie SM7client auf einem eigenständigen Host installieren und Speicher-
subsysteme über den Fibre Channel-E/A-Pfad statt über das Netzwerk verwalten
möchten, müssen Sie die TCP/IP-Software auf dem Host installieren und dem
Host eine statische IP-Adresse zuweisen.

Installationsanweisungen für NetWare 5.1
Bevor Sie die Software installieren, stellen Sie folgende Punkte sicher:

v Auf der Verwaltungsstation sind mindestens 60 MB Plattenspeicherplatz verfüg-
bar.

v Der Bildschirm ist auf eine Bildschirmauflösung von mindestens 800x600 Pixel
und auf eine Farbpalette von mindestens 256 Farben festgelegt.

v Es sind alle anderen Programme geschlossen.

Führen Sie die folgenden Schritte aus, falls Sie das SM7client-Paket auf einer
Verwaltungsstation mit dem Betriebssystem NetWare 5.1 installieren:

1. Legen Sie die Installations-CD zum IBM FAStT Storage Manager in das
CD-ROM-Laufwerk ein, und geben Sie den folgenden Befehl ein:
load cdrom

2. Hängen Sie den Datenträger an.

3. Klicken Sie auf Novell → Install .

4. Klicken Sie auf Add , und befolgen Sie die Anweisungen auf dem Bildschirm.

5. Klicken Sie auf den Knopf Directory Tree .

Das Fenster Directory Tree wird geöffnet.

6. Wählen Sie das CD-ROM-Laufwerk aus.

7. Gehen Sie in das Verzeichnis \Netware51\SM7client.

8. Wählen Sie die Datei program.ni aus, und klicken Sie dann auf OK.

9. Klicken Sie auf OK.

Nach dem Kopieren der Dateien wird das Fenster License Agreement geöffnet.

10. Klicken Sie auf Accept , um fortzufahren.

Das Nachrichtenfenster für den Kopiervorgang der Dateien wird geöffnet.

11. Wenn die Installation vollständig ist, klicken Sie auf Finish .

Verwenden Sie folgende Prozedur, um zu prüfen, ob die Installation erfolgreich war:

1. Klicken Sie auf Novell → Programs .

2. Prüfen Sie, ob der Client Netfinity Fibre Channel Storage Manager in der Liste
der Programme angezeigt wird.

3. Fahren Sie mit Schritt „Installieren des Host-Agent-Paketes” auf Seite 37 fort.

Anmerkung: Das Host-Agenten-Paket muss auch dann installiert werden, wenn
Sie SM7client nur auf einer Verwaltungsstation installieren.
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Installieren des Host-Agent-Paketes
Verwenden Sie folgende Prozedur, um das Host-Agenten-Paket auf jedem Host-
Computer zu installieren, der mit einem oder mehreren Speichersubsystemen ver-
bunden ist. SM7agent besteht aus den folgenden Komponenten:

v Der Host-Agenten-Software, die für die Host-Agenten-Verwaltung der Speicher-
subsysteme erforderlich ist

v Dem Dienstprogramm Hot Add zum dynamischen Hinzufügen von logischen
Laufwerken zum Betriebssystem. Siehe „Verwenden des Dienstprogramms Hot
Add” auf Seite 52.

v Dem Dienstprogramm SM7devices, mit dem die Beziehung der logischen Lauf-
werke zu den Einheitennamen des Betriebssystems angezeigt wird. Weitere
Informationen finden Sie unter „Verwenden des Dienstprogramms SM7devices”
auf Seite 53.

Wichtig: Das Host-Agenten-Paket muss auch dann installiert werden, wenn Sie
Speichersubsysteme nicht über die Host-Agenten-Software verwalten möchten. Das
Host-Agenten-Paket enthält Dienstprogramme, die für die Verwaltung von Speicher-
subsystemen erforderlich sind.

Stellen Sie vor dem Installieren der Software Folgendes sicher:

v Der Host ist mit Novell NetWare 5.1 und Service Pack 1 konfiguriert.

v Der Host verfügt über mindestens 20 MB freien Plattenspeicherplatz.

v Der Bildschirm ist auf eine Auflösung von mindestens 640x480 Pixel und auf eine
Farbpalette von mindestens 256 Farben festgelegt.

v Sie haben alle anderen Programme geschlossen.

Falls Sie für das Speichersubsystem die Methode Host-Agenten-Verwaltung ver-
wenden, stellen Sie für den Busadapter des Hosts den Maximalwert für LUN auf 32
ein. Standardmäßig ist der Wert für die UTM-LUNs (UTM = Universal Transport
Module) auf 31 und muss an das Betriebssystem gemeldet werden, damit
SM7agent das UTM identifizieren und Verbindungen zu ihm herstellen kann.
Weitere Informationen finden Sie in der README-Datei, die sich im Verzeichnis
Netware51/host_adapter auf der Installations-CD zum IBM FAStT Storage Manager
befindet.

Führen Sie die folgenden Schritte aus, um das Host-Agenten-Paket zu installieren:

1. Legen Sie die Installations-CD zum IBM FAStT Storage Manager in das
CD-ROM-Laufwerk ein, und geben Sie den folgenden Befehl ein:
load cdrom

2. Hängen Sie den CD-Datenträger an.

3. Klicken Sie auf Novell → Install .

4. Klicken Sie auf Add , und befolgen Sie die Anweisungen auf dem Bildschirm.

5. Klicken Sie auf den Knopf Directory Tree .

Das Fenster Directory Tree wird geöffnet.

6. Wählen Sie das CD-ROM-Laufwerk aus.

7. Gehen Sie in das Verzeichnis \Netware51\SM7agent.

8. Wählen Sie die Datei product.ni aus, und klicken Sie dann auf OK.
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9. Klicken Sie auf OK.

Nach dem Kopieren der Dateien wird das Fenster License Agreement geöffnet.

10. Klicken Sie auf Accept , um fortzufahren.

Die Dateien werden kopiert.

11. Wenn die Installation vollständig ist, klicken Sie auf Finish .

Anmerkung: Damit SM7agent beim Systemstart des Servers aktiviert wird,
kann jetzt in der Datei autoexec.ncf ein Eintrag angelegt werden.

Verwenden Sie folgende Prozedur, um SM7agent zu laden und zu prüfen, ob die
Installation erfolgreich war:

1. Schalten Sie in das Fenster Serverkonsole und zur Eingabeaufforderung um,
und geben Sie den folgenden Befehl ein:
Load SM7agent

Der Agent wird gestartet und zeigt die folgende Nachricht an, während die
UTM-LUNs abgefragt werden:
Aktivierung läuft

Weitere Informationen finden Sie unter „Automatisches Starten des Host-Agenten”
auf Seite 40.
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Kapitel 4. Beenden der Installation

In diesem Kapitel wird beschrieben, wie Sie Enterprise Management und Subsys-
tem Management starten und den Installationsvorgang beenden.

Stoppen und Starten des Host-Agenten
Verwenden Sie die in den folgenden Abschnitten beschriebenen Prozeduren, um
die auf dem Host installierte Host-Agenten-Software zu starten und zu beenden.

Anmerkung: Wurde kein Access Volume erfasst, stoppt die Host-Agenten-Software
automatisch. Falls Sie eine NVSRAM-Datei herunterladen, die ein
Access Volume aktiviert oder die LUN ändert, die für das Access
Volume verwendet wird, müssen Sie die Host-Agenten-Software stop-
pen und neu starten oder für den Host einen Neustart ausführen,
damit die Erkennungsfunktion der durch den Host-Agenten verwalte-
ten Speichersubsysteme aktiviert wird.

Stoppen des Host-Agenten
Sie müssen die Host-Agenten-Software beenden, wenn Sie Speichersubsysteme
hinzufügen möchten. Wenn Sie den Service neu starten, entdeckt der Host-Agent
die neuen Speichersubsysteme und fügt sie der Verwaltungsdomäne hinzu.

Gehen Sie wie folgt vor, um den Host-Agenten zu beenden:

1. Drücken Sie in der Systemkonsole STRG+Esc , und wählen Sie dann System
Console .

2. Geben Sie an der Eingabeaufforderung den folgenden Befehl ein:
unload sm7agent

3. Drücken Sie die Eingabetaste .

4. Kehren Sie zu ConsoleOne zurück. Drücken Sie Strg+Esc, und wählen Sie
dann Xserver → Graphical Console .

Manuelles Starten des Host-Agenten
Die Host-Agenten-Software muss manuell gestartet werden, wenn das System
gestartet wird oder falls es gestoppt wird, um Speichersubsysteme hinzuzufügen.

Gehen Sie wie folgt vor, um den Host-Agenten manuell zu starten:

1. Drücken Sie in der Systemkonsole Strg+Esc, und wählen Sie dann System
Console .

2. Geben Sie an der Eingabeaufforderung den folgenden Befehl ein:
sm7agent

3. Drücken Sie die Eingabetaste .

4. Der Inhalt des Fensters wird gelöscht, wenn der (NLM-) Bereich erstellt worden
ist.

5. Kehren Sie zu ConsoleOne zurück. Drücken Sie Strg+Esc, und wählen Sie
dann Xserver → Graphical Console .
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Automatisches Starten des Host-Agenten
Gehen Sie wie folgt vor, damit die Host-Agenten-Software beim Systemstart auto-
matisch konfiguriert wird:

1. Öffnen Sie die Datei autoexec.ncf mit einem Dateieditierprogramm.

2. Suchen Sie den Abschnitt, in dem das Laden der Java-Laufzeitumgebung (JRE)
beschrieben ist. Geben Sie hinter dieser Zeichenfolge die folgende Zeile ein:
sys:system/sm7agent

3. Sichern und schließen Sie die editierte Datei autoexec.ncf.

Starten des Fensters Enterprise Management
Das Fenster Enterprise Management ist das erste Fenster, das geöffnet wird, wenn
Sie die Software starten. Verwenden Sie das Fenster Enterprise Management für
die folgenden Aufgaben:

v Die Speichersubsysteme, die Sie verwalten möchten, hinzufügen und suchen.

v Eine umfassende Anzeige aller Speichersubsysteme in Ihrer Verwaltungsdomäne
anzeigen.

v Stapelverwaltungsaufgaben von Speichersubsystemen mit Hilfe des Script Edi-
tors durchführen.

Gehen Sie wie folgt vor, um das Fenster Enterprise Management zu starten:

1. Falls Sie den SM7agent verwenden, starten Sie ihn im Fenster Server Console.

Geben Sie im Fenster Server Console den folgenden Befehl ein:
Load SM7agent

2. Klicken Sie in der Xserver Graphical Console auf Novell → Programs .

3. Klicken Sie auf Netfinity Fibre Channel Storage Manager 7-Client .

Die Client-Software wird gestartet, und das Fenster Enterprise Management
sowie das Fenster Confirm Initial Automatic Discovery werden geöffnet (siehe
Abb. 16).

Abbildung 16. Fenster Confirm Initial Automatic Discovery
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Anmerkung: Es kann einige Minuten dauern, bis das Fenster Enterprise
Management geöffnet wird. In dieser Zeit wird kein Cursor ange-
zeigt, der den Wartestatus symbolisiert (zum Beispiel eine Sand-
uhr). Wenn Sie die erste automatische Erkennung nicht ausführen
möchten, klicken Sie auf No. Sie können mittels der Menüoption
Edit → Add Device Hosts und Speichersubsysteme hinzufügen.
Weitere Informationen finden Sie unter „Hinzufügen von
Einheiten” auf Seite 42.

4. Klicken Sie auf Yes, um eine erste automatische Erkennung der Hosts und
Speichersubsysteme zu beginnen, die an das lokale Teilnetz angeschlossen
sind, in dem die Verwaltungsstation installiert ist.

Die Software sendet eine Broadcast-Nachricht über das lokale Teilnetz, in
dem die Verwaltungsstation installiert ist. Sie erkennt mit dem Host-Agenten
verwaltete Speichersubsysteme, wenn die Hosts, die die Netzverwaltungs-
verbindungen zu den Speichersubsystemen zur Verfügung stellen, auf den
Broadcast-Betrieb reagieren. Mit der Software werden direkt verwaltete
Speichersubsysteme erkannt, wenn die Controller in diesen Speicher-
subsystemen auf die Broadcast-Nachricht antworten.

Anmerkung: Es kann bis zu einer Minute dauern, bis das Fenster Enterprise
Management nach der ersten automatischen Erkennung aktualisiert
wird.

Wenn Sie den automatischen Erkennungsvorgang stoppen müssen, schließen Sie
das Fenster Enterprise Management.

Wenn die erste automatische Erkennung beendet ist, können Sie alle Hosts und
Speichersubsysteme anzeigen, die an das lokale Teilnetz angeschlossen sind
(siehe Abb. 17).

Aus technischen Gründen kann die folgende Abbildung nicht auf Deutsch zur Verfü-
gung gestellt werden.

Abbildung 17. Fenster Enterprise Management
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Wenn nicht alle Hosts und Speichersubsysteme angezeigt werden, gehen Sie fol-
gendermaßen vor:

v Überprüfen Sie die Hardware und die Verbindungen auf mögliche Fehler.
(Spezielle Prozeduren finden Sie in der Hardware-Dokumentation.)

v Detaillierte Informationen finden Sie in der Enterprise Management-Hilfe unter
dem Hilfethema über die Erkennung von Speichersubsystemen.

v Stellen Sie sicher, dass sich die Einheit im lokalen Teilnetz befindet. Ist dies nicht
der Fall, müssen Sie die Option Add Device verwenden.

Anmerkung: Wenn eine der Einheiten den Status Unresponsive aufweist, entfer-
nen Sie die Einheit mit Hilfe der Software aus der Verwaltungs-
domäne, und fügen Sie sie erneut hinzu. Anweisungen zum Entfer-
nen und Hinzufügen von Einheiten finden Sie in der
Onlinehilfefunktion von Enterprise Management.

Ein Speichersubsystem kann unter Umständen nach einer automatischen Erken-
nung in der Einheitenbaumstruktur dupliziert werden, wenn das Speichersubsystem
direkt verwaltet wird, jedoch an einen Host angeschlossen ist, auf dem die Host-
Agenten-Software installiert und aktiv ist. In diesem Fall können Sie das doppelt
vorhandene Symbol für die Speicherverwaltung aus der Baumstruktur für die Ein-
heiten mit Hilfe der Option Remove Device im Fenster Enterprise Management
löschen.

Fahren Sie mit dem Schritt „Hinzufügen von Einheiten” fort.

Hinzufügen von Einheiten
Sie können weitere Hosts oder Speichersubsysteme außerhalb des lokalen Teil-
netzes hinzufügen. Weitere Informationen zu dieser Option finden Sie in der Online-
hilfefunktion des Fensters Enterprise Management.

Wichtig:
Wenn Sie Speichersubsysteme über die Host-Agenten-Software verwalten und phy-
sisch neue Speichersubsysteme hinzufügen, müssen Sie den Host-Agenten-Service
stoppen und erneut starten, so dass die neuen Speichersubsysteme erkannt wer-
den können. Wechseln Sie dann zum Fenster Enterprise Management, und klicken
Sie auf Tools → Rescan , um der Verwaltungsdomäne neue Speichersubsysteme
hinzufügen.

Fahren Sie mit dem Schritt „Überwachen von Speichersubsystemen” fort.

Überwachen von Speichersubsystemen
Um die Rahmenbedingungen der Speichersubsysteme in Ihrer Verwaltungsdomäne
überwachen zu können, muss Enterprise Management gestartet werden. Weitere
Informationen zum Überwachen von Speichersubsystemen finden Sie in der Online-
hilfefunktion von Enterprise Management.
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Einrichten von Alert-Hinweisen
Wenn Sie zur Verwaltungsdomäne Einheiten hinzugefügt haben, richten Sie Alert-
Hinweisoptionen ein, um kritische Ereignisse an die Speichersubsysteme weiterzu-
geben. Die folgenden Optionen sind für die Alert-Hinweise verfügbar:

v Hinweis an eine ausgewählte Netzverwaltungsstation (NMS = Network Manage-
ment Station) anhand von SNMP-Traps (SNMP = Simple Network Management
Protocol) (Weitere Informationen erhalten Sie unter „Einrichten der NMS für die
SNMP-Hinweise”.)

v Hinweis an ausgewählte E-Mail-Adressen

v Hinweis an ausgewählte alphanumerische Empfangsgeräte (wenn ein Software-
paket von Fremdherstellern zum Konvertieren von E-Mail-Nachrichten verwendet
wird)

Anmerkung: Das Fenster Enterprise Management muss geöffnet bleiben, wenn
Sie die Bedingungen der Speichersubsysteme, die Bestandteil Ihrer
Verwaltungsdomäne sind, überwachen möchten. Sie können das
Fenster aber minimieren. Wenn Sie das Fenster schließen, erhalten
Sie keine Alert-Hinweise. Weitere Informationen zu den Optionen für
Alert-Hinweise finden Sie in der Onlinehilfefunktion von Enterprise
Management.

Einrichten der NMS für die SNMP-Hinweise
Wenn Sie die Alert-Hinweise unter Verwendung der SNMP-Traps einrichten möch-
ten, müssen Sie zuerst eine Datei für die Verwaltungsinformationsdatenbank (MIB =
Management Information Base) auf die ausgewählte Netzverwaltungsstation kopie-
ren. Verwenden Sie diese Prozedur, um die MIB-Datei auf der Netzverwaltungs-
station einzurichten.

Wichtig: Sie müssen die ausgewählte NMS lediglich einmal einrichten.

1. Kopieren Sie von der Installations-CD für den IBM FAStT Storage Manager aus
dem Verzeichnis \Netware51\SM7mib die Datei Arrayman.mib auf die Netz-
verwaltungsstation.

2. Befolgen Sie die Schritte, die für Ihre spezielle Netzverwaltungsstation erforder-
lich sind, um die MIB-Datei zu kompilieren.

Anmerkung: Einzelheiten zu den erforderlichen Schritten erhalten Sie von
Ihrem Netzadministrator oder entnehmen Sie der Dokumentation,
die speziell für das von Ihnen verwendete NMS-Produkt erhältlich
ist.

Konfigurieren von Alert-Zieladressen
Konfigurieren Sie die Zieladressen für die SNMP-Traps und für die E-Mails, die
Alert-Hinweise erhalten sollen, mit Enterprise Management. Weitere Hinweise zur
genauen Vorgehensweise finden Sie in der Onlinehilfefunktion von Enterprise
Management.
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Starten von Subsystem Management
Mit dem Fenster Subsystem Management können Sie die ausgewählten Subsys-
teme verwalten.

Gehen Sie wie folgt vor, um das Fenster Subsystem Management für ein ausge-
wähltes Speichersubsystem zu öffnen:

1. Wählen Sie im Fenster Enterprise Management ein Speichersubsystem aus.

2. Klicken Sie auf Tools → Manage Device .

Das Fenster Subsystem Management für das ausgewählte Speichersubsystem
wird von der Software angezeigt (siehe Abb. 18).

Anmerkung: Mit dem geöffneten Fenster Subsystem Management können Sie
lediglich das ausgewählte Speichersubsystem verwalten. Sie kön-
nen jedoch mehrere Fenster Subsystem Management öffnen, um
weitere Speichersubsysteme zu verwalten.

Abbildung 18. Fenster Subsystem Management (Modelle 3526 und 3552)
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Umbenennen von Speichersubsystemen
Wenn Sie Storage Manager 7.02 zum ersten Mal starten, sind die Speicher-
subsysteme nicht benannt. Sie müssen das Fenster Subsystem Management ver-
wenden, um jedes Speichersubsystem, das <unnamed> ist, wie gewünscht umzu-
benennen. Beziehen Sie sich auf die im Informationsdatensatz eingegebenen
Namen, den sie unter Verwendung von Tabelle 13 auf Seite 55 erstellt haben.
Anschließend gehen Sie in die Onlinehilfefunktion von Subsystem Management,
und lesen Sie die Angaben zum Thema Umbenennen von Speichersubsystemen.
Das Hilfethema enthält ausführliche Anweisungen zum Umbenennen von Speicher-
subsystemen.

Ausführen weiterer Verwaltungs-Tasks für Speichersubsysteme
Sie können die folgenden Verwaltungs-Tasks für Speichersubsysteme ausführen:
v Herunterladen der Controller-Firmware
v Herunterladen der Controller-NVSRAM
v Suchen eines Speichersubsystems
v Anzeigen eines Profils für ein Speichersubsystem
v Eingeben oder Ändern eines Kennworts für ein Speichersubsystem
v Erstellen und Verwalten von logischen Laufwerken und Bereichen
v Verwenden der Leistungsüberwachung
v Erstellen von Speicherpartitionen (falls gültig)

Anmerkung: Um Speicherpartitionen zu erstellen, müssen Sie den weltweit gülti-
gen Namen oder den Anschlussnamen für jeden Host-Adapter in
jedem mit dem Speichersubsystem verbundenen Host ermitteln.

Weitere Informationen über diese und sonstige Verwaltungs-Tasks für Speicher-
subsysteme finden Sie in den entsprechenden Hilfethemen der Onlinehilfefunktion
von Subsystem Management.

Fahren Sie mit dem Schritt „Ändern der Konfigurationseinstellungen im NVSRAM”
auf Seite 46 fort.

Abbildung 19. Fenster Subsystem Management (Modell 3542)
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Ändern der Konfigurationseinstellungen im NVSRAM
Führen Sie die Scripts zur NVSRAM-Konfiguration aus, um das Speichersubsystem
für die Verwendung mit NetWare-Hosts in einer Standardumgebung (ohne Cluster)
zu konfigurieren. Mit der folgenden Prozedur können Sie diese Scripts anwenden:

1. Legen Sie die Installations-CD zum IBM FAStT Storage Manager in das
CD-ROM-Laufwerk ein.

2. Geben Sie in der Xserver Graphical Console den folgenden Befehl ein:
load cdrom

3. Hängen Sie den CD-Datenträger an.

4. Klicken Sie in der Xserver Graphical Console auf Novell → Netfinity Fibre
Channel Storage Manager 7 .

5. Klicken Sie im Fenster Confirm Initial Automatic Discovery auf Yes. Falls Sie
auf No klicken, können Sie Einheiten noch manuell mit der Option Edit → Add
Device hinzufügen.

Die Speichersubsysteme, die über die Firmware-Version 4.x verfügen, werden
automatisch erkannt.

6. Klicken Sie im rechten Teilfenster des Fensters Enterprise Management von
Netfinity Fibre Channel Storage Manager 7 mit der rechten Maustaste auf ein
Speichersubsystem, und klicken Sie dann im Menü auf Execute Script .

Das Fenster Script Editor wird geöffnet.

7. Klicken Sie im Menü des Fensters Script Editor auf File → Load Script .

Wenn Sie zum Speichern der Änderungen in newscript.scr aufgefordert wer-
den, klicken Sie auf No.

8. Wählen Sie im Fenster Load Script die Datei <CD-ROM
volume>\Netware51\scripts\Netware5.scr aus, und klicken Sie dann auf Open .

9. Klicken Sie im Menü des Fensters Script Editor auf Tools → Verify and
Execute .

Die Nachricht:
Script execution complete

wird im unteren Teilfenster des Fensters Script Editor angezeigt.

10. Klicken Sie im Fenster Script Editor auf File → Load Script .

Wenn Sie zum Speichern der Änderungen in newscript.scr aufgefordert wer-
den, klicken Sie auf No.

11. Wählen Sie im Fenster Load Script die Datei <CD-ROM
volume>\Netware51\scripts\NW_mpio.scr, und klicken Sie dann auf Open .

12. Wählen Sie im Fenster Script Editor Tools → Verify and Execute aus.
Script execution complete

wird im unteren Teilfenster des Fensters Script Editor angezeigt.

13. Starten Sie den Controller neu, damit die Änderungen wirksam werden
können.
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Kapitel 5. Betriebssystemunterstützung

Dieses Kapitel enthält Informationen zur Verwendung der Speicherverwaltungs-
software mit Novell NetWare.

Einschränkungen für Novell NetWare
Wichtig: Überprüfen Sie immer, ob sich auf einem Installationsdatenträger eine
README-Datei befindet. Diese README-Datei enthält wichtige Informationen, die
bei der Erstellung dieser Dokumentation Installation und Unterstützung noch nicht
zur Verfügung standen.

In Tabelle 12 werden die Einschränkungen erklärt, die für die Verwendung von IBM
FAStT Storage Manager Version 7.02 mit Novell NetWare gelten.

Tabelle 12. Einschränkungen und Umgehungsverfahren für Novell NetWare

Einschränkung Umgehungsverfahren

Durch Klicken auf einen senkrechten
Schiebepfeil (auf oder ab) wird das Schiebe-
feld über die ganze Länge der Schiebeleiste
ans andere Ende verschoben.

Dies ist ein bekannter Fehler in der Laufzeit-
umgebung von Java. Klicken Sie stattdessen
auf das Schiebefeld, und verschieben Sie es,
bis Sie an der gewünschten Stelle im Hilfe-
fenster angelangt sind.

Die Migration von logischen Laufwerken (Ent-
fernen eines Laufwerk-Sets mit logischen
Laufwerken von einem Speichersubsystem
und Einsetzen in ein anderes Speicher-
subsystem) wird nicht unterstützt, da die
Konfiguration verloren gehen kann.

Benachrichtigen Sie den Kundendienst.

Wenn Sie Speichersubsysteme über die
Host-Agenten-Software verwalten und die
Speicherverwaltungssoftware zum Herunter-
laden der Controller-Firmware verwenden,
benötigt der Übertragungsvorgang bis zu 10
Minuten.

Keines.

Wenn Sie ein neues Speichersubsystem mit
einem einzelnen Controller konfigurieren,
müssen Sie den Controller in Steckplatz A
platzieren. Die Controller-Firmware erkennt
einen einzelnen Controller nicht bzw. kann
nicht mit ihm kommunizieren, wenn Steck-
platz A nicht belegt ist. Diese Einschränkung
gilt nicht für Speichersubsysteme, die
ursprünglich mit zwei Controllern konfiguriert
wurden.

Keines.

Eine allgemeine Ringleitungskonfiguration
(verwaltete Hubs, die an Switches ange-
schlossen sind) wird nicht unterstützt.

Keines.
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Tabelle 12. Einschränkungen und Umgehungsverfahren für Novell NetWare (Forts.)

Einschränkung Umgehungsverfahren

Wenn Sie einen Lüfter oder ein Netzteil
(CRU, Customer Replaceable Unit) bei
laufendem System aus einem Speicher-
subsystem entfernen, zeigt die Speicher-
verwaltungssoftware keinen Fehler an, und
die Komponente wird nicht als fehlend ange-
zeigt.
Anmerkung: Ausfälle bei Lüftern und Netz-
teil-CRU werden gemeldet.

Ersetzen Sie die fehlenden Lüfter- oder
Netzteil-CRU sofort, um die Redundanz zu
gewährleisten. Stellen Sie sicher, dass Lüfter
oder Netzteil-CRU ordnungsgemäß in der
Controllereinheit eingesetzt ist.

Anzahl der unterstützten logischen Laufwerke
Folgende Einschränkungen gelten für die Unterstützung logischer Laufwerke:

v Bei der Verwendung der Novell Storage Management Services (SMS) können bis
zu 256 LUNs bzw. die für das Modell des Host-Adapters in Ihrem System maxi-
mal verfügbare Anzahl konfiguriert werden.

v Host-Adapter unterstützen die Höchstzahl an logischen Laufwerken. Weitere
Informationen hierzu finden Sie in der Dokumentation des Host-Adapters.

v Bei der Methode der Host-Agenten-Verwaltung wird ein bestimmtes logisches
Laufwerk, das sogenannte Access Volume (Zugriffsdatenträger) verwendet, um
mit den Controllern im Speichersubsystem zu kommunizieren. Das Access
Volume verwendet eines der zulässigen logischen Laufwerke. Wenn Sie das
Speichersubsystem über die Host-Agenten-Software verwalten, steht deshalb ein
LUN weniger zur Verfügung als die Höchstzahl, die von Novell NetWare und dem
Host-Adapter unterstützt wird.
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Erstellen von logischen Laufwerken
Ein logisches Laufwerk ist ein logisches Objekt, das Sie als grundlegende Struktur
zum Speichern von Daten im Speichersubsystem erstellen. Ein logisches Laufwerk
wird mit einer bestimmten RAID-Stufe für ein Array konfiguriert, um dem Bedarf von
Anwendungen nach Datenverfügbarkeit und Fibre Channel-E/A-Leistung gerecht zu
werden. Ein logisches Laufwerk wird vom Betriebssystem als ein einzelnes Lauf-
werk erkannt. Sie können logische Laufwerke in einer Standardkonfiguration hinzu-
fügen oder löschen.

Wenn Sie mit der Speicherverwaltungssoftware neue logische Laufwerke erstellen,
müssen Sie die neuen Laufwerke zu Novell NetWare hinzufügen. Informationen
zum Hinzufügen von Laufwerken finden Sie in der Dokumentation zu Novell Net-
Ware. Beachten Sie, dass jedes logische Laufwerk (nicht das Array) von Novell Net-
Ware als ein einzelnes Laufwerk erkannt wird. Führen Sie nach dem Erstellen eines
logischen Laufwerks die Hot Add- und SM7devices-Dienstprogramme aus, die im
Lieferumfang der Speicherverwaltungssoftware enthalten sind. Das Hot Add-Dienst-
programm fügt neue logische Laufwerke zum Betriebssystem hinzu, und das
SM7devices-Dienstprogramm identifiziert logische Laufwerke über den vom
Betriebssystem zugeordneten Einheitennamen. Weitere Informationen zur Verwen-
dung dieser Dienstprogramme finden Sie unter „Verwenden des Dienstprogramms
Hot Add” auf Seite 52 und „Verwenden des Dienstprogramms SM7devices” auf Sei-
te 53.

Bevor Sie logische Laufwerke mit der Speicherverwaltungssoftware oder mit Hilfe
von Configure → Reset Configuration löschen, beenden Sie alle Ein- und Aus-
gabevorgänge am betroffenen Speichersubsystem. Hängen Sie dann alle NetWare-
Datenträger ab, die den logischen Laufwerken zugeordnet sind.
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Installieren von QLogic Management Suite Java
Die Software QLogic Management Suite Java (QMSJ) enthält den QLogic GUI-
Einheitentreiber, der zur Unterstützung der Überbrückungsfunktion erforderlich ist.
Die GUI können Sie zum Konfigurieren von LUNs, zum Speichern und zum Über-
brücken verwenden.

Anmerkung: Weitere Informationen finden Sie in der Onlinehilfefunktion.

Führen Sie die folgenden Schritte aus, um QLogic Management Suite Java zu
installieren:

1. Legen Sie die Installations-CD zum IBM FAStT Storage Manager in das
CD-ROM-Laufwerk ein.

2. Ordnen Sie dem Datenträger SYS des NetWare-Servers ein Laufwerk zu.

3. Gehen Sie in das Verzeichnis Netware51\qlremote.

4. Klicken Sie auf install.exe .

Das Fenster Introduction wird geöffnet.

5. Klicken Sie auf Next .

Das Fenster Important Information wird geöffnet. Lesen Sie die Anwendungs-
hinweise für QMSJ.

6. Klicken Sie auf Next .

Das Fenster Choose Install Folder wird geöffnet.

7. Klicken Sie auf Next .

Das Fenster Choose Install Set wird geöffnet.

8. Um nur die QMSJ Java-GUI zu installieren, wählen Sie QMSJ GUI.

9. Um den QMSJ Novell NetWare 5.x Agent zu installieren, wählen Sie
QMSJ Novell NetWare 5 .

10. Um die Java-GUI und den Novell NetWare Agent zu installieren, klicken Sie
auf Customize .

11. Klicken Sie auf Next .

Falls Sie Customize gewählt hatten, wird das Fenster Customize Install geöff-
net.

12. Stellen Sie die Installationssets auf Custom Set ein.

13. Aktivieren Sie die Markierungsfelder QMSJ GUI,
QMSJ Novell NetWare 5.x Agent und Help .

14. Klicken Sie auf Install .

Das Fenster Novell NetWare Disk Selection wird geöffnet.

15. Wählen Sie den Laufwerkbuchstaben, der dem Datenträger SYS Ihres
NetWare-Servers zugeordnet ist, oder geben Sie ihn ein.

Das Fenster Install Complete wird geöffnet.

16. Klicken Sie auf Done .

17. Starten Sie den NetWare-Server neu, um den Agenten QMSJ zu starten.

50 IBM FAStT Storage Manager Version 7.02 für Novell NetWare: Installation und Unterstützung



Konfigurationsbeispiel für QLogic Management Suite Java
Beziehen Sie sich beim Konfigurieren der Zuordnung von Einheiten und LUN auf
dieses Beispiel.

1. Öffnen Sie QLogic Management Suite Java. Das Fenster Host Bus Adapter
View wird geöffnet.

2. Klicken Sie auf Connect .

Das Fenster Connect to Host wird geöffnet.

3. Geben Sie den Namen oder die IP-Adresse des Hosts ein.

Anmerkung: Kann nach Eingabe des Host-Namens keine Verbindung herge-
stellt werden, wird ein Eintrag in der Host-Datei oder der DNS-
Tabelle erforderlich.

4. Klicken Sie auf Configure .

Das Fenster Fibre Channel Port Configuration wird geöffnet.

5. Klicken Sie auf Tools → Auto Configure .

6. Klicken Sie auf Tools → Load Balance → All LUNs .

7. Klicken Sie mit der rechten Maustaste auf den Knotennamen der Einheit.

Es werden die Optionen Information und Configure LUN mask angezeigt.

8. Wählen Sie Configure LUN mask .

Anmerkung: Die Standardkonfiguration ordnet alle LUNs dem ersten FAStT-
Host-Adapter zu. Sie können das Fenster Fibre Channel Port
Configuration verwenden, um für den Busadapter Ihres Hosts
die Überbrückung und den Lastausgleich zu konfigurieren.

Das Fenster Fibre Channel LUN Configuration wird geöffnet. Sie können hier
Ihre bevorzugten und Alternativpfade konfigurieren sowie an der LUN-Konfigu-
ration Änderungen vornehmen.
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9. Nach dem Klicken auf einen beliebigen Pfad werden die verfügbaren
Konfigurationsoptionen angezeigt. Informationen zu speziellen Konfigu-
rationsdaten finden Sie in der Onlinehilfefunktion.

Anmerkung: Für Ihre LUNs könnten deren bevorzugte Pfade geändert wer-
den müssen, um eine Übereinstimmung mit der Konfiguration
des FAStT-Speichersubsystems herzustellen.

10. Klicken Sie auf OK.

Das Fenster Fibre Channel Port Configuration wird geöffnet.

11. Die Installation ist jetzt abgeschlossen. Klicken Sie auf Apply .

Das Fenster Security Check wird geöffnet.

12. Klicken Sie auf OK.

Das Fenster Apply Configuration wird geöffnet.

13. Klicken Sie auf OK.

Verwenden des Dienstprogramms Hot Add
Die Host-Agenten-Software enthält ein Dienstprogramm namens Hot Add, mit dem
neue logische Laufwerke dynamisch hinzugefügt werden können, ohne das System
neu zu starten. Das Dienstprogramm registriert die neuen logischen Laufwerke, so
dass Sie mit Disk Administrator Partitionen erstellen können, Gerätenamen hinzufü-
gen können usw. Das Hot Add-Dienstprogramm wird als Teil des Host-Agenten-Pa-
kets installiert.

Nachdem die logischen Laufwerke auf einem bestimmten Speichersubsystem
erstellt wurden, wechseln Sie zum Host, der mit dem Speichersubsystem
verbunden ist, und führen Sie die folgenden Schritte aus, um das Hot Add-
Dienstprogramm zu verwenden:

1. Geben Sie in der Xserver Graphical Console den folgenden Befehl ein:
hot_add

2. Drücken Sie die Eingabetaste.

Die neuen logischen Laufwerke stehen über den Festplatten-Manager zur Verfü-
gung.
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Verwenden des Dienstprogramms SM7devices
Die SM7agent-Software enthält ein Dienstprogramm namens SM7devices, mit dem
Sie das logische Laufwerk des Speichersubsystems sichten können, das einem
bestimmten Gerätenamen des Betriebssystems zugeordnet ist. Dies ist hilfreich,
wenn Sie mit Hilfe von nwconfig Laufwerke, Datenträger oder eine Kombination von
beiden für das logische Laufwerk erstellen möchten.

Nachdem die logischen Laufwerke auf einem bestimmten Speichersubsystem
erstellt wurden, wechseln Sie zum Host, der mit dem Speichersubsystem
verbunden ist, und führen Sie die folgenden Schritte aus, um das SM7devices-
Dienstprogramm zu verwenden:

1. Geben Sie in der Serverkonsole den folgenden Befehl ein:
SM7devices

2. Drücken Sie die Eingabetaste.

Die Software zeigt Informationen zur Identifikation der Einheit an. Beispielsweise
kann Folgendes angezeigt werden:
V596-A3-D0:0[Storage Subsystem MARKETING, Logical Drive DEBIT,
LUN 0, WWN <600a0b800007545c0000008d3a308b6e>]

V596-A3-D0:1 [Storage Subsystem MARKETING, Logical Drive DEBIT, LUN 1,
WWN <600a0b80000756ec000000a93a307d2a>]

V596-A3-D0:1F [Storage Subsystem MARKETING, Logical Drive Access volume,
LUN 31, WWN <600a0b800007545c0000009000000000>]

Where V596-A3-D0:0;

Die Ziffern am Beginn jeder Zeile bilden den Einheitennamen. Der Einheiten-
name identifiziert den Adapter oder die Einheit wie folgt:
Lieferantennummer [V596]. Eine eindeutige Nummer für den Lieferanten
dieser Einheit.

Adapternummer [A3]. Die Instanznummer eines mit NWPA registrierten
Adapters.
In diesem Beispiel identifiziert A3 die erste im Server installierte Instanz
dieses Adapters.

Einheitennummer [D0]. Die Nummer des Datenträgers bzw. der sonstigen
Einheit.

Nummer der logischen Einheit [0,1,1F]. Die LUN identifiziert die
einzelnen Einheiten, wenn an einen Bus mehrere Einheiten angeschlossen sind.

Storage Subsystem x = der Name des Speichersubsystems
Logical Drive x = der Name des logischen Laufwerks
LUN x = die Nummer der dem logischen Laufwerk zugeordneten logischen Einheit
WWN x = der weltweit gültige Name des logischen Laufwerks
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Deinstallieren von Softwarekomponenten der Speicherverwaltung
Gehen Sie wie folgt vor, um eine oder mehrere Komponenten von Storage Manager
7.02 zu deinstallieren.

1. Klicken Sie in der Xserver Graphical Console auf Novell → Install .

Das Fenster Add/Remove Programs Properties wird geöffnet.

2. Wählen Sie aus der Liste von Programmen die Komponente aus, die deinstal-
liert werden soll.

Wählen Sie z. B. Fibre Channel Storage Manager 7 Client .

3. Klicken Sie auf Add/Remove .

Das Fenster Confirm File Deletion wird geöffnet.

4. Klicken Sie auf Yes, um den Deinstallationsvorgang zu starten.

5. Wenn die Deinstallation vollständig ist, klicken Sie auf OK.
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Anhang A. Speichersubsystem-
/Controllerinformationsdatensatz

Tabelle 13 stellt ein Datenblatt bereit, auf dem Sie die Namen des Speichersub-
systems, Verwaltungstypen, Hardware-Ethernet-Adressen und IP-Adressen proto-
kollieren können. Erstellen Sie eine Kopie dieser Tabelle, und vervollständigen Sie
die Informationen für die Speichersubsysteme und Controller. Verwenden Sie die in
Tabelle 13 protokollierten Informationen, um die BOOTP-Tabelle für Netzserver und
den Host oder die DNS (Domain Name System)-Tabelle zu definieren. Die Informa-
tionen in Tabelle 13 sind Ihnen beim Hinzufügen von Speichersubsystemen nach
der Erstinstallation behilflich. Die Spaltenüberschriften zeigen die Seitenreferenzen
der detaillierten Anweisungen für den Erhalt der Informationen. Einen Beispiel-
informationsdatensatz finden Sie in Abb. 5 auf Seite 16.

Tabelle 13. Speichersubsystem- und Controllerinformationsdatensatz

Name des
Speicher-
subsystems
(siehe Seite 19)

Verwaltungsart
(siehe Seite 15)

Controller — Ethernet- und IP-
Adressen sowie Host-Name
(siehe Seiten 20 und 22)

Host —
IP-Adresse und
Host-Name
(siehe Seite 22)

Name des
Speicher-
subsystems:

Name des
Speicher-
subsystems:

Name des
Speicher-
subsystems:

Name des
Speicher-
subsystems:

Name des
Speicher-
subsystems:

Name des
Speicher-
subsystems:

Name des
Speicher-
subsystems:

Name des
Speicher-
subsystems:
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Anhang B. Hinweise

Diese Veröffentlichung ist für Produkte und Services entwickelt worden, die auf dem
deutschen Markt angeboten werden.

Möglicherweise bietet IBM die in diesem Dokument beschriebenen Produkte, Ser-
vices oder Funktionen in anderen Ländern nicht an. Informationen über die gegen-
wärtig im jeweiligen Land verfügbaren Produkte und Services sind bei Ihrem IBM
Ansprechpartner erhältlich. Hinweise auf IBM Lizenzprogramme oder andere IBM
Produkte bedeuten nicht, dass nur Programme, Produkte oder Dienstleistungen von
IBM verwendet werden können. Anstelle der Produkte, Programme oder Dienstleis-
tungen können auch andere, ihnen äquivalente Produkte, Programme oder Dienst-
leistungen verwendet werden, solange diese keine gewerblichen oder andere
Schutzrechte von IBM verletzen. Die Verantwortung für den Betrieb von Fremd-
produkten, Fremdprogrammen oder Fremdservices liegt jedoch beim Kunden.

Für in diesen Dokument beschriebene Erzeugnisse und Verfahren kann es IBM
Patente oder IBM Patentanmeldungen geben. Mit der Auslieferung dieses Hand-
buchs ist keine Lizenzierung dieser Patente verbunden. Lizenzanforderungen sind
schriftlich an

IBM Europe
Director of Licensing
92066 Paris
La Défense Cedex
France

zu richten. Anfragen an obige Adresse müssen auf Englisch formuliert werden.

DIESE VERÖFFENTLICHUNG WIRD VON DER INTERNATIONAL BUSINESS
MACHINES CORPORATION OHNE JEDE GEWÄHR, OB DIREKT ODER INDI-
REKT, ZUR VERFÜGUNG GESTELLT, EINSCHLIESSLICH - JEDOCH NICHT
BESCHRÄNKT AUF - INDIREKT GELTENDER GEWÄHRLEISTUNGEN HINSICHT-
LICH DER WAHRUNG VON SCHUTZBESTIMMUNGEN, DER HANDELS-
FÄHIGKEIT ODER DER EIGNUNG FÜR EINEN BESTIMMTEN ZWECK. Einige
Rechtsordnungen erlauben bei bestimmten Transaktionen keine Ablehnungser-
klärungen für direkte oder indirekte Gewährleistungen. Daher trifft dies für Sie mög-
licherweise nicht zu.

Trotz sorgfältiger Bearbeitung können technische Ungenauigkeiten oder Druckfehler
in dieser Veröffentlichung nicht ausgeschlossen werden. Die Angaben in diesem
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Alle Rechte vorbehalten.

Verarbeiten von Datumsdaten
Dieses IBM Hardwareprodukt und diese IBM Softwareprodukte wurden so entwi-
ckelt, dass sie bei Benutzung gemäß der dazugehörigen IBM Dokumentation in der
Lage sind, Datumsdaten innerhalb des 20. und 21. Jahrhunderts und zwischen
diesen beiden Jahrhunderten korrekt zu verarbeiten, bereitzustellen oder zu emp-
fangen, vorausgesetzt, dass alle anderen Produkte (z. B. Hardware, Software und
Firmware), die zusammen mit ihnen benutzt werden, richtige Datumsdaten ord-
nungsgemäß mit ihnen austauschen.

IBM übernimmt keine Zuständigkeit für die Verarbeitung von Datumsdaten durch
Produkte von Drittanbietern, selbst wenn diese Produkte vorinstalliert sind oder auf
andere Art und Weise von IBM vertrieben werden. Wenden Sie sich direkt an die
Hersteller dieser Produkte, um Informationen über deren Leistungsspektrum zu
erhalten und sie ggf. zu aktualisieren. Dieses IBM Hardwareprodukt kann keine
Fehler verhindern, die auftreten, wenn Software, Upgrades oder Peripheriegeräte,
die Sie für den Austausch von Datumsdaten verwenden, Datumsdaten nicht korrekt
verarbeiten.
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Marken
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Antwort

IBM FAStT Storage Manager
Version 7.02 für Novell NetWare
Installation und Unterstützung

Teilenummer 19K6083

Anregungen zur Verbesserung und Ergänzung dieser Veröffentlichung nehmen wir gerne entgegen. Bitte informie-
ren Sie uns über Fehler, ungenaue Darstellungen oder andere Mängel.

Zur Klärung technischer Fragen sowie zu Liefermöglichkeiten und Preisen wenden Sie sich bitte entweder an Ihre
IBM Geschäftsstelle, Ihren IBM Geschäftspartner oder Ihren Händler.

Unsere Telefonauskunft ″HALLO IBM ″ (Telefonnr.: 01803/31 32 33) steht Ihnen ebenfalls zur Klärung allge-
meiner Fragen zur Verfügung.

Kommentare:

Danke für Ihre Bemühungen.

Sie können ihre Kommentare betr. dieser Veröffentlichung wie folgt senden:
v Als Brief an die Postanschrift auf der Rückseite dieses Formulars
v Als E-Mail an die folgende Adresse: ibmterm@de.ibm.com

Name Adresse

Firma oder Organisation

Rufnummer E-Mail-Adresse



Antwort IBM

IBM Deutschland GmbH
SW TSC Germany

70548 Stuttgart





IBM

Teilenummer: 19K6083

(1P) P/N: 19K6083
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